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1 Overview 

About This Chapter 

This topic describes the fault categories, precautions of troubleshooting, fault information 

sources, overall troubleshooting process and how to obtain help of huawei when you can not 

deal with the fault. 

1.1  Fault Level 

This topic describes how to rectify faults at different levels. 

1.2  Fault Categories 

The troubleshooting method varies according to fault category. 

1.3  Precautions 

Before locating and troubleshooting faults, maintenance personnel must read and comply with 

the relative precautions. 

1.4  Fault Sources 

SoftCo faults are found in customer complaints, routine maintenance, and alarms. 

1.5  Troubleshooting Process 

Before proceeding, learn the basic troubleshooting process. 

1.6  Technical Support 

Huawei Technologies Co., Ltd. provides customers with comprehensive technical support and 

service. Please feel free to contact our local office or company headquarters. 

1.1 Fault Level 

This topic describes how to rectify faults at different levels. 

Depending on the impact and scope of the fault, faults are classified as either emergency 

faults or ordinary faults. 

Emergency faults refer to those that occur suddenly and affect a wide range of services or 

devices. Emergency faults, such as host breakdown and global service congestion, seriously 

affect network operations and the quality of service (QoS). 
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The following faults are emergency faults: 

 All or the most majority of SoftCo functions are unavailable. 

− A single board or all boards are unavailable. 

− The SoftCo is powered off. 

 All SoftCo services are globally interrupted for a long time or calls are congested. 

− None of the media gateways can register with the network, for example, a media 

gateway is disconnected immediately after it is registered. 

− Calls are congested at all user terminals. For example, users cannot make or receive 

calls, or cannot hear the dial tone or busy tone after picking up the phone. 

− Calls are congested at all office directions. For example, users fail to make or receive 

calls. 

 Some SoftCo services are interrupted for a long time or calls are congested. 

− Some media gateways fail to register with the network, or disconnect immediately 

after they are registered. 

− Call congestion occurs in some user terminals. For example, users cannot make or 

receive calls, or cannot hear the dial tone or busy tone after picking up the phone. 

− Call congestion occurs in some office directions. For example, users fail to make or 

receive calls. 

Ordinary faults refer to those faults that are not emergency faults. The policies for locating 

and rectifying faults and the applicable reference documents are different for emergency and 

ordinary faults. 

Table 1-1 Policies for locating and rectifying faults 

Fault Level Processing Policy Reference 

Ordinary fault Locate and rectify the fault 

immediately. 

See SoftCo Product 

Document > Fault 

Management > 

Troubleshooting. 

Emergency fault Restore the service that has 

been affected as soon as 

possible, and then find the 

root cause of the fault. 

See SoftCo Product 

Document > Fault 

Management > Emergency 

Maintenance. 

 

1.2 Fault Categories 

The troubleshooting method varies according to fault category. 

Currently, unified communications solution faults of huawei are classified into the following 

categories: 

 3 Basic Call Faults 

 4 Trunk Faults 

 5 Service faults 

 6 System Device Faults 
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 7 Terminal and gateway faults 

1.3 Precautions 

Before locating and troubleshooting faults, maintenance personnel must read and comply with 

the relative precautions. 

 Receive training before troubleshooting faults to gain knowledge about operational 

regulations and industry security regulations. 

 Understand basic operational skills and emergency handling techniques for the 

equipment. 

 Take ESD measures, for example, wear ESD wrist straps, when replacing and 

maintaining device parts. 

 Record original information in detail when any problem occurs during troubleshooting, 

such as troubleshooting step, symptom description, alarm information and log 

information. 

 Record all major operations, such as system restart and software loading. Confirm the 

feasibility of an operation before performing it. Do not attempt any operation before 

taking proper backup, emergency, and security measures. 

 Modify the data under authorization and control. Back up the data before modifying it, 

and record the modified content. 

 Never run third-party software to query or modify the database. 

1.4 Fault Sources 

SoftCo faults are found in customer complaints, routine maintenance, and alarms. 

Customer Complaints 

When receiving a complaint from a customer, ask the customer to: 

1. Describe the fault symptom. 

2. Check the parameter settings. 

3. Use the UCMaint to capture log information and send it to Huawei technical support. 

Routine Maintenance 

Routine maintenance is a set of preventive measures taken regularly during the normal 

running of the system. The maintenance personnel detect and eliminate potential defects or 

troubles at the earliest time to ensure sustained safety and system stability. 

During routine maintenance, check for the following: 

 Whether an alarm is reported. 

 Whether the call detail record (CDR) pool is full. 

 Whether the trunk link is normal. 

 Whether the board is running normally. 

 Whether the service network port is working normally. 
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 Whether all users are in normal state. 

 
For details, see Routine Maintenance. 

Alarm Information 

Device alarms reflect a device's running status. When a major or critical alarm is reported, the 

device is faulty or potentially faulty and must be cleared immediately. 

The alarm information includes the following: 

 The board is faulty. 

 The CDR pool is full. 

 The trunk link is faulty. 

 The network is faulty. 

 The E1 trunk is faulty. 

 
To view the cause of a fault and methods for rectifying the fault, use the Operation and Maintenance 

Unit (OMU). 

1.5 Troubleshooting Process 

Before proceeding, learn the basic troubleshooting process. 

Figure 1-1 shows the overall troubleshooting process. 
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Figure 1-1 Troubleshooting process 
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Collecting Fault Scenario Information 

Clear fault scenario information helps to quickly locate faults. When a fault occurs, collect the 

following information: 

 Time and location 

 Description of the fault symptom. 

 Operations that a user or a maintenance engineer performed before the fault occurred. 

 Measures that have taken after the fault occurred and the results. 

 Services that were affected by the fault, including the fault impact and scope. 

Checking Whether the Fault is an Normal fault 

Upon receiving the fault information, determine whether the fault is an normal fault. 

 If yes, locate and rectify the fault according to this document.  
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 If no, restore the services according to the SoftCo Product Document > Fault 

Management > Emergency Maintenance. 

Judging Fault Categories 

Judge the fault categories according to the fault symptoms.  

Performing Troubleshooting 

Performing the troubleshooting is compose of locating the fault and rectifying the fault. 

Locating a fault uses to find the fault reason, and the rectifying the fault uses to remove the 

fault which restore the device to run normally. 

Verifying That a Fault Is Removed 

After measures are taken, verify that the fault symptoms have disappeared.  

Contacting Huawei Technical Support for Help 

If the fault persists after you locate the fault and rectify it according to this document, contact 

Huawei technical support for remote or onsite help.  For details on how to obtain Huawei 

technical support, see Huawei Technical Support. 

Before seeking help, ensure that the following information is available: 

 Full name of the office where the fault occurred 

 Contact information, including a contact person name and a fixed-line phone number or 

a mobile number 

 Fault scenario and symptoms 

 Remote maintenance environment and remote access parameters 

Writing a Troubleshooting Report 

After verifying that the fault has been rectified, record the troubleshooting process and write a 

troubleshooting report.  

 
A recommended troubleshooting report consists of four topics: fault symptom, fault locating, fault 

rectification, and preventive suggestions. 

1.6 Technical Support 

Huawei Technologies Co., Ltd. provides customers with comprehensive technical support and 

service. Please feel free to contact our local office or company headquarters. 

Huawei Technologies Co., Ltd. 

Address: Administration Building, Huawei Technologies Co., Ltd., Bantian, Longgang 

District, Shenzhen, P. R. China 

Postal Code: 518129 

Website: http://support.huawei.com 
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Customer service telephone: 0755-28560000 4008302118 

Fax: 0755-28560111 

Email: support@huawei.com  
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2 Common Methods for Locating Faults 

About This Chapter 

The unified communications (UC) solution provides various methods to locate faults. 

2.1  Data Configuration Analysis 

Use the UCMaint to collect data configuration information which locate the configuration 

fault. 

2.2  Alarm Analysis 

An alarm is an important sign for a fault or an event. Alarms help detect faults in a timely 

manner, and provide suggestions for troubleshooting. 

2.3  Log Analysis 

Logs record key events and information that are generated while programs are running. By 

viewing and analyzing logs, you can locate and rectify faults. 

2.4  Signaling Analysis 

Signaling records the process of establishing a call. By analyzing the signaling, you can find 

out possible causes of call failure and rectify the fault. 

2.5  Network Information Analysis 

This topic describes how to obtain network information. 

2.1 Data Configuration Analysis 

Use the UCMaint to collect data configuration information which locate the configuration 

fault. 

Use the UCMaint to collect information through one click. The operation is as follow: 

1. Create the ErrCollectfile. 

a. In the main menu, choose File > New, the New dialog is displayed, as shown in 

Figure 2-1. 
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Figure 2-1 New 

 

 

b. In the New list-dialog, choose ErrCollect, then click OK. 

2. Connect SoftCo. 

a. In the toolbar, click , the Connect SoftCo dialog is diaplayed, as shown in 

Figure 2-2. 

Figure 2-2 Connect SoftCo 

 

 

b. Input SoftCo IP address, click Connect. 

3. In the main window, click , the related configure data will displayed down the main 

window, as shown in Figure 2-3. 

You view whether the data is right, suck as the board status, trunk link, and so on. 
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Figure 2-3 Data configuration information 

 

 

2.2 Alarm Analysis 

An alarm is an important sign for a fault or an event. Alarms help detect faults in a timely 

manner, and provide suggestions for troubleshooting. 

The priority for rectifying faults depends on the alarm severity. 

 Critical: global alarms that seriously affect device operations, for example, a power 

supply fault. Critical alarms must be handled immediately; otherwise, the system may 

crash. 

 Major: board or physical circuit alarms that occur in a certain scope. For example, the 

fault of the physical circuit. Major alarms must be handled immediately; otherwise, the 

services cannot run normally. 

 Minor: general faults or event alarms that describe the working status of each board or 

physical circuit. You must locate the cause to remove potential problems. 

 Warning: prompt message, for example, a message indicating that a device has been 

restored. Warning alarms do not affect system performance and services. No action is 

required. 

 
If the Operation and Maintenance Unit (OMU) or Unified Communications Element Management 

System (UCEMS) is used, the alarm severity is displayed in the alarm window. 

The procedure for handling an alarm is as follows: 

1. Find the critical and major alarms among all alarms. 

2. View the cause of each alarm and handle the alarm. 
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3. Verify that the alarm is cleared. 

− If the alarm is cleared, the fault is rectified. 

− If the fault is not rectified, find out other possible causes. 

To view alarms, use the OMU or UCEMS, or observe the indicators. 

 Observe the SoftCo indicators to obtain alarm information. 

Table 2-1 and Table 2-2 describe the indicators. 

Table 2-1 Indicator status on the SoftCo chassis 

Indicator Color Status Description 

POWER Green  On: The power supply is normal. 

 Off: There is no power. 

RUN Green  Blinking (at 4 Hz): The board is writing data to 

the FLASH memory while the system is running. 

 Blinking (at 0.5 Hz): The system is running 

normally. 

 On: The board is faulty. 

 Off: There is no power, the board is faulty, or the 

system is starting. 

ALARM Red Applicable only to the SoftCo9500. 

 Blinking: An alarm is being reported. 

 Off: No alarm is being reported. 

 

Table 2-2 Board status indicators 

Indicator Color Status Description 

RUN Green  Blinking (at 4 Hz): The board is writing data to 

the FLASH memory while the system is 

running. 

 Blinking (at 2 Hz): The board is writing data to 

the FLASH memory during system startup. 

 Blinking (at 1 Hz): The board is starting. It is 

applicable only to Main Control Units (MCUs). 

 Blinking (at 0.5 Hz): The system is running 

normally. 

 On: The board is faulty. 

 Off: There is no power, or the board is faulty. 

ALARM Red For MCUs: 

 Blinking: An alarm is being reported while the 

system is running. 

 Off: No alarm is being reported. 

For other boards: 
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Indicator Color Status Description 

 Blinking: The board is starting, or the user does 

not add the board by using a command after the 

SoftCo has started. 

 Off: The board is running normally. 

ACT 

(active/standby 

indicator) 

Green Applicable only to the MCUs. 

 On: This board is the active board. 

 Off: This board is the standby board. 

LOS (signal loss 

indicator) 

Yellow Applicable only to Digital Trunk Units (DTUs). 

 On: Signals are lost. 

 Off: No signal is lost. 

RFA (remote 

alarm indicator) 

Green Applicable only to the DTUs. 

 On: The peer device is not receiving signals. 

 Off: The peer device is running normally. 

 

 Use the OMU to view alarm information. 

1. On the OMU main page, click the Realtime Alarm tab to view alarm information, as 

shown in Figure 2-4. 

Figure 2-4 Realtime Alarm tab page 

 

 

2. In the alarm browse area, double-click a required alarm. The detailed alarm information 

is displayed, as shown in Figure 2-5. 
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Figure 2-5 Detailed alarm information 

 

 

3. Rectify alarms based on the suggestions provided. 

 
The OMU installation package is obtained from http://support.huawei.com. For details on how to use the 

OMU, see the OMU Client Help. 

 Use the UCEMS to view alarm information. 

1. On the main menu, choose Fault > Browse Current Alarm. 

2. In the alarm browse window, select a required alarm. 

The alarm details along with the suggestions are displayed, as shown in Figure 2-6. 
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Figure 2-6 Current alarm information 

 

 

 
The UCEMS installation package is obtained from http://support.huawei.com. For details on how to use 

the UCEMS, see the iManager UCEMS Help. 

2.3 Log Analysis 

Logs record key events and information that are generated while programs are running. By 

viewing and analyzing logs, you can locate and rectify faults. 

The unified communications (UC) solution provides the UCMaint to view logs. 

1. Click the Switch tab. Select required log modules, and click Set to enable the log 

module functions, as shown in Figure 2-7. 
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Figure 2-7 Switch tab page 

 

 

2. Click the LogSearch tab. Set parameters such as the calling number and called number, 

and click QueryLog, as shown in Figure 2-8. 

Figure 2-8 LogSearch tab page 

 

 

3. Double-click a record to view the log details, as shown in Figure 2-9. The calling 

number 5001 and called number 5002 are contained in the log. 
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Figure 2-9 Log information 

 

 

 
The UCMaint installation package is obtained from http://support.huawei.com. For details on how to use 

the UCMaint, see the UCMaint User Guide. 

2.4 Signaling Analysis 

Signaling records the process of establishing a call. By analyzing the signaling, you can find 

out possible causes of call failure and rectify the fault. 

 View signaling information using a packet capture tool.  

For details, see How to Use the Wireshark. 

 View signaling information using the Operation and Maintenance Unit (OMU). 

Figure 2-10 shows the SS7 signaling process. 
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Figure 2-10 Signaling tracing 

 

 

 
The OMU installation package is obtained from http://support.huawei.com. For details, see the OMU 

Client Help. 

2.5 Network Information Analysis 

This topic describes how to obtain network information. 

Running the ping command to view network information 

 Run the ping -count<1-65535> waittime<1-255> ttl<1-255> <a.b.c.d> command on 

a SoftCo to check the network status. The following is an example which the network 

status is normal: 

[%SoftCo9500(config)]#ping -count 10 192.168.10.11  

  

====  Command executed success !  ====  

  

Pinging 192.168.10.11 with 32 bytes of data:  

  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  
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Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Reply from 192.168.10.11: bytes=32  time<10ms ttl=64  

Ping statistics for 192.168.10.11  

        Packets: Sent = 10, Received = 10, Lost = 0<0% loss>,  

Approximate round trip times in milli-seconds:  

        Minimum = 0ms, Maximum = 0ms, Average = 0ms  

  

====  Command executed success !  ==== 

 Run the ping<a.b.c.d> -l<count> command in the command line interface (CLI) of a 

personal computer to check the network status.  

1. Choose Start > Run, and then enter the cmd command in the Run dialog box. 

2. Click OK to display the CLI, as shown in Figure 2-11. 

Figure 2-11 Cmd 

 

 

3. Enter ping command to check the network status. The abnormal network status is shown 

in Figure 2-11 

Table 2-3 lists the IP bearer network quality. 

Table 2-3 IP bearer network quality 

Network Quality One-Way Delay 
(ms) 

Packet Loss Rate Jitter (ms) 

Good 

(recommended) 

≤ 40 ≤ 0.1% ≤ 10 

Poor ≤ 100 ≤ 1% ≤ 20 

Terrible ≤ 400 ≤ 5% ≤ 60 
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Table 2-4 lists the data service usage that is available based on the IP bearer network quality. 

Table 2-4 Data service usage 

Service Type Good Poor Terrible 

Fax Transparent 

transmission 

(G.711a/u) 

Available Unavailable Unavailable 

T.38 Available Available Unavailable 

Modem Transparent 

transmission 

(G.711a/u) 

Available Unavailable Unavailable 
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3 Basic Call Faults 

About This Chapter 

Basic call faults include one-way audio, no voice, low call quality, call connection fault, digit 

sending and collection fault, number display fault, and prompt tone fault. 

3.1  Background 

This topic describes call principles. 

3.2  Only One Party Can Hear the Peer Voice 

This topic describes how to troubleshoot a fault that occurs when only one party can hear the 

peer voice. 

3.3  Calling Party and Called Party Cannot Hear Each Other 

This topic describes how to troubleshoot a fault that causes failure for the calling party and 

the called party to hear each other. 

3.4  Volume Is Low or High 

This topic describes how to troubleshoot the low volume or the high volume. 

3.5  Noise in the Line 

This topic describes how to troubleshoot the noise in the line. 

3.6  Echoes In the Line 

This topic describes how to troubleshoot the echoes in the line. 

3.7  Voice Is Intermittent 

This topic describes how to troubleshoot the voice intermittent. 

3.8  Call Connection Abnormally 

This topic describes how to troubleshoot the call connection abnormally. 

3.9  Sending and Collecting Digits Fail 

This topic describes how to troubleshoot a fault that causes failure to send and collect digits. 

3.10  Number Is Displayed Abnormally 

This topic describes a fault that causes number display abnormal. 
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3.11  Voice Prompt Faults 

This topic describes how to troubleshoot voice prompt faults. 

3.12  Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

3.1 Background 

This topic describes call principles. 

3.1.1 Number Conversion 

The number conversion is used for changing the original the calling number to other number 

which the peer device requires. 

The common number conversion and the priority of number conversion is as follows. 

1. Long and short numbers 

A user has a short number and a long number. The short number is used for intra-office 

calls(such as 5000). The long number(such as 68906000), which is allocated by the 

PSTN, is displayed or is used for a PSTN user to directly call a intra-office user. 

2. Number mapping 

This method is used when irregular numbers are changed. For example, the long number 

of user 5000 is 68905000 and the mapping number is 83785000.  

3. Number change 

A user can change calling and called numbers as required. For example, the long number 

of user 5000 is 68905000 and the mapping number is 83785000. Set outgoing prefix 7 

and perform three types of number changes of the calling number. The settings are as 

follows: 

//Add a user and set a long number for the user.  

config add sipue eid 5000 authorizationtype noauth  

config add subscriber eid 5000 dn 5000 longdn 68905000  

//Set number mapping for the user.  

config add numbermap innernum 5000 externnum 83785000  

//Add the number change rule index, and change the number to 68905888.  

config add predeal index 1 changetype modify changepos 0 changelen 32 newdn 68905888   

//Perform the switch between long and short numbers, number mapping, and number change.  

config add prefix dn 7 callcategory basic callattribute local cldpredeal no 

officeselectcode 1 clipredeal yes cliindex 1 climap yes uselongcli yes  

 

If a user dials a number that starts with 7, the long calling number, that is, 68905000, is 

displayed on the called phone. The mapping number 83785000 is displayed only when 

the user does not set the long number. If the user does not set the long number and 

number mapping, the number after change, that is, 68905888, is displayed. 

4. Trunk bearer 

This method is used in the scenario where outgoing prefixes are the same, but numbers 

are different. If a user dials a number that starts with 7+external, the number 68985000 

will displayed when outgoing A office and the number 83786000 will displayed when 

outgoing B office.  
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3.1.2 Prompt Tone 

Prompt tones include the dial tone, service prompt tone, and customized ring back tone 

(CRBT). The prompt tones are saved in the voice file. Faults can be located based on prompt 

tones. 

 
A voice.zip package is located on each Media Resource Unit (MRU), Media Resource Server (MRS), or 

Main Control Unit (MCU). 

Pay attention to the following: 

 The SoftCo plays dial tones, keypad tones, and prompt tones (for example, "Sorry. The 

number you dial does not exist. Try later.") for IAD, IP phone, and SIP users. 

 If the peer user is called, the device that plays the prompt tone varies. 

− If a common RBT is heard and the local RBT is enabled on the peer device, the peer 

device plays the RBT. If the local RBT is not enabled on the peer device, the SoftCo 

plays the RBT. 

− If the SoftCo is connected to the IP Multimedia Subsystem (IMS). Thanks to the IMS 

do not support to hear the SoftCo prompt tone, the IMS plays the service prompt tone, 

for example, "Your call has been restricted". 

3.2 Only One Party Can Hear the Peer Voice 

This topic describes how to troubleshoot a fault that occurs when only one party can hear the 

peer voice. 

Symptom 

After a call is set up, only one party can hear the peer voice. 

Possible Causes 
 The network is abnormal. 

 The terminal is faulty. 

 The Real-time Transport Protocol (RTP) port on the router is disabled. 

 The Network Address Translation (NAT) is enabled on the network. 

 The codec negotiation specified in the signaling is incorrect. 

 SDP messages are abnormal. 

 RTP packets are abnormal. 

 UDP packets are abnormal. 

Procedure 

Step 1 Check whether the network is normal. For details, see 2.5 Network Information Analysis. 

If the network is faulty, check whether the network cables are connected correctly. 

Step 2 Change the terminal to check whether the fault is rectified. 

Step 3 Check whether the RTP port of the router is enabled. 
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If the RTP port is not enabled, see router-related document to enable it. 

Step 4 Check whether there are IP addresses on different segments, such as 192.168.10.10 and 

10.40.10.10. 

If different IP address segments exist, NAT traversal happens. Use the Session Border 

Controller (SBC) to map IP addresses or establish a Virtual Private Network (VPN). 

Step 5 Use the commissioning record function to record a call through the trunk and locate the fault 

(peer or local device). 

 
The commissioning record function does not apply to the SIP trunk or MRS board. 

1. Use the Trivial File Transfer Protocol (TFTP) tool to set the directory as the one storing 

voice files. 

2. Run the debug recordtone by firstcall pid pra out_toneid 251 recordtype alerting or 

debug recordtone by firstcall pid pra in_toneid 251 recordtype alerting command to 

record an outgoing or incoming call through the trunk. 

Table 3-1 describes the command line interface (CLI) parameters. 

Table 3-1 Parameter description 

Paramet
er 

Description Value Range 

by Recording criteria   Firstcall 

  Caller 

  Called 

  Tkc 

pid Trunk module name, with the recording 

criteria being firstcall 

 At0 

 Pra 

 R2 

 Tup 

 Isup 

number Calling/Called number, with the recording 

criteria being caller or called 

– 

tckno Recording criteria: Tkc 0–65535 

in_toneid ID of the channel that stores incoming trunk 

data recording  

251 

out_tonei

d 

ID of the channel that stores outgoing trunk 

data recording  
251 

recordtyp

e 

Recording type  FSK 

 Alerting 

 Speaking 
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Voice files can be stored only through channel 251. Multiple recording commands cannot be 

implemented at the same time. 

3. (Optional) Manually store voice files that cannot be stored automatically. 

a. Run the show record information command to view Last record BoardNo and 

record the board number. 

b. Run the config upload subvoice toneid 251 solt<2–9> command to save the voice 

file. 

4. Check the quality of the stored voice file to and locate the fault (peer or local device). 

Step 6 Use the packet capture tool to check whether media sets contained in the Session Description 

Protocol (SDP) messages of the two parties have the same content. The SDP messages of the 

both parties contain g711A, as shown in Figure 3-1. 

If the two parties' SDP messages do not have the same content, change the voice codec type. 

For details, see How to Use the Wireshark. 

Figure 3-1 Voice codec 

 

 

To change the voice codec type on the SoftCo, proceed as follows: 

1. Run the show system information command to view the voice codec type, as shown in 

Figure 3-2. 

Figure 3-2 Voice codec type on the SoftCo 
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2. Run the config system codetype <g711a&g711u&g729&g723> command to set the 

voice codec type. 

3. Run the config modify office no<0-254>codetype 

<g711a&g711u&g729&g723&none> command to change the priority of the voice 

codec. 

To change the voice codec type on the IAD, proceed as follows: 

1. Run the display sip send-capability command to view the voice codec type. 

2. Run the sip send-capability voip pri<0-9> <G711a|G711u|G729|G723> ptime 

<10ms|20ms|30ms> command to change the priority of the voice codec. 

To change the voice codec type on the IP phone, proceed as follows: 

1. Start Microsoft Internet Explorer and enter the IP address of the IP phone (such as 

http://192.168.104.16) in the address box to go to the IP phone login page. 

2. Enter the password (admin by default). 

3. Click the ACCOUNT tab. Set the voice codec type, as shown in Figure 3-3. 

Figure 3-3 Voice codec type on the IP phone 

 

 

Step 7 Use the packet capture tool to check whether the INVITE SDP message is normal. 

1. Check whether the SDP message's media attribute is sendrecv, as shown in Figure 3-4. 

If the media attribute is sendonly or recvonly, skip to Step 10. 

Figure 3-4 Media attribute 

 

 

2. Check whether the media attribute of the INVITE SDP message sent by the peer device 

carries the message silenceSupp:off, as shown in Figure 3-5. 

If silenceSupp:off is contained in the INVITE SDP message, run the config sip 

silenceofftofax flag off command to disable silenceSupp:off in Config mode. 
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Figure 3-5 silenceSupp:off message 

 

 

Step 8 Use the packet capture tool to check the RTP packet content. 

1. Check whether RTP packets are received and sent bidirectionally. 

If RTP packets are received and sent unidirectionally, skip to Step 10. 

2. Run the ping <a.b.c.d> command to check whether the SoftCo IP address is used by 

another device. 

If the IP address is used by another device, the media access control (MAC) address of 

the RTP packet is incorrect. Run the config system ip mode static address<a.b.c.d/M> 

command in Config mode to change the SoftCo IP address. 

3. Use Capsens to convert the RTP message that has been captured to a voice file, and 

analyze the file. If the voice file is empty, analyze the log of the device that sent the RTP 

message to locate the fault. For details on how to use Capsens, see 8.1 How to use the 

Capsens. 

 
Before capturing packets, pay attention to the following points: 

 If two broadband terminals, such as two SIP phones, are connected, capture the IP packets on the 

terminals. 

 If the SoftCo is used to connect calls that pass through different trunks, capture the packets on the 

SoftCo service network port. 

Step 9 Check whether the UDP packet checksum is correct. Figure 3-6 shows the correct checksum. 

If the checksum is incorrect, skip to Step 10. 

Figure 3-6 Correct checksum 

 

 

Step 10 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 
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3.3 Calling Party and Called Party Cannot Hear Each Other 

This topic describes how to troubleshoot a fault that causes failure for the calling party and 

the called party to hear each other. 

Symptom 

After a call is set up, neither of the two parties can hear the peer voice. 

Possible Causes 

The possible causes are as follows: 

 The Field Programmable Gate Array (FPGA) version information is not the same as that 

described in the release notes delivered with the product. 

 The network is abnormal. 

 The terminal is faulty. 

 The RTP port on the router is disabled. 

 The Network Address Translation (NAT) is enabled on the network. 

 The codec negotiation in the signaling is incorrect. 

 SDP messages are abnormal. 

 RTP packet are abnormal. 

 UDP packet are abnormal. 

Procedure 

Step 1 Run the show version command to check whether the Field Programmable Gate Array 

(FPGA) version information is the same as SoftCo Version Configuration Table in the release 

notes delivered with the product, as shown in Figure 3-7. 

If no, obtain the correct version to upgrade. 

Figure 3-7 Version information 

 

 

Step 2 Perform steps 1 to 9 in 3.2 Only One Party Can Hear the Peer Voice. 
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Step 3 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.4 Volume Is Low or High 

This topic describes how to troubleshoot the low volume or the high volume. 

Symptom 

The volume is low or high in the line. 

Possible Causes 

The device gain is improper. 

Procedure 

Step 1 If the AT0 trunk interface is used for interconnecting devices, change the AT0 outgoing gain 

(dagain) and incoming gain (adgain) by follow way. The default values of the outgoing and 

incoming gains are 6. 

 Run the following commands to adjust the outgoing and incoming gains:  

 If the AT0 trunk interface provided by the SoftCo5816 chassis is used, run the config 

modify at0tkc mpu portinboard 0-7 dagain <0-12> adgain <0-12> command. 

 If the AT0 trunk interface provided by the SoftCo5816 board is used, run the config 

modify at0tkc card slot <1-4> portinboard 0-7 dagain <0-12> adgain <0-12> 

command. 

 If the AT0 trunk interface provided by the SoftCo9500 board is used, run the config 

modify at0tkc slot  <2-9> portinboard 0-7 dagain <0-12> adgain <0-12>command. 

The playdefvol is play tone gain. The ipchandefvol is IP channel gain. The 

tdmchandefvol is TDM channel gain. The default values of the playdefvol, the 

ipchandefvol and tdmchandefvol gains are 12. 

Step 2 If another trunk is used to connect devices, run the config modify mrsparas playdefvol 

<0-15> ipchandefvol <0-15> tdmchandefvol <0-15> command to increase the outgoing 

and incoming gains. In this command, default values of playdefvol, ipchandefvol, and 

tdmchandefvol are 12. 

Step 3 If an IAD is used, run the dsp send-gain <2-64> and dsp recv-gain <2-64> commands to 

change the outgoing and incoming gains. 

Step 4 If an IP Phone is used, press the arrow keys to adjust the volume. 

Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.5 Noise in the Line 

This topic describes how to troubleshoot the noise in the line. 
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Symptom 

There is noise in the line. 

Possible Causes 

The possible causes are as follows: 

 The SoftCo is not grounded. 

 The terminal is faulty. 

 The device gain is improper. 

 The peer device is abnormal. 

Procedure 

Step 1 Check whether the SoftCo is grounded. 

Step 2 Change the terminal to see whether the fault is rectified. 

Step 3 See 3.4 Volume Is Low or High Step 1 to Setp 2 to reduce device gain. 

Step 4 If there is cross-talk, check whether there is interference on the line. 

Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.6 Echoes In the Line 

This topic describes how to troubleshoot the echoes in the line. 

Symptom 

There is echoes in the line. 

Possible Causes 

The possible causes are as follows: 

 The network is abnormal. 

 The echoes are acoustic feedback from the user's microphone. 

 The device gain is improper. 

 The EC function is not enabled. 

 The Echo Cancellation (EC) function is incorrectly. 

Procedure 

Step 1 Check whether the network status is normal. For details, see 2.5 Network Information 

Analysis. 

Step 2 The PSTN user covers the microphone to check whether the echoes disappear. 
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If yes, the echoes are acoustic. Acoustic echoes generally occur when the hands-free function 

is enabled. To prevent acoustic echoes, disable the hands-free function. 

Step 3 If a SoftCo is used, run the show system voip argu algo g711 command to check whether the 

EC function is ON, as shown in Figure 3-8. 

If no, run the config system voip algo g711 echocancel on command to enable the EC 

function. 

Figure 3-8 Echo cancellation 

 

 

Step 4 See 3.4 Volume Is Low or High Step 1 to Setp 2 to reduce device gain. 

Step 5 Contact the peer office's engineers to check whether the Echo Cancellation (EC) function is 

correctly configured in the peer gateway. 

Step 6 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.7 Voice Is Intermittent 

This topic describes how to troubleshoot the voice intermittent. 

Symptom 

The voice is intermittent in the line. 

Possible Causes 

The possible causes are as follows: 

 The network is abnormal. 

 The silence suppression function is enabled. 

Procedure 

Step 1 Check the network status. see 2.5 Network Information Analysis. 

Step 2 Use the commissioning record function to record a call through the trunk and locate the fault 

(peer or local device). For details, see Step 5. 

Step 3 If a SoftCo is used, run the show system voip argu algo g711 command to check whether the 
silence suppression function is OFF, as shown in Figure 3-9. 
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If no, run the config system voip algo g711 silencesup off command to disable the silence 

suppression function. 

Figure 3-9 Silence suppression 

 

 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.8 Call Connection Abnormally 

This topic describes how to troubleshoot the call connection abnormally. 

Symptom 

Call connection faults are as follows: 

 Connect a Call takes more than ten second. 

 The caller will hear busy tone after callee unhooking. 

Possible Causes 

The possible causes are as follows: 

 The prefix attribution is abnormal. 

 If the user is SIP or H.248, the digitmap is incorrect. 

 The length of VU collected digits is incorrect. 

 The codec negotiation in the signaling is incorrect. 

Procedure 

Step 1 Run the show prefix dn <string> command to check the minlen whether less than 

intra-office number. 

if yes, run the config modify prefix dn <string> minlen <string> command to modify. 

Step 2 If the user is SIP or H.248, run the show digitmap command to check digitmap whether meet 

requirement. 

The least length of the default digitmap is four. If the intra-office number less than it, run the 

config add digitmap protocol h248 name <string> value <string> command and config 

modify digitmap protocol sip value <string> command to modify digitmap. 
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For example, if the intra-office number is 700, run the config modify digitmap protocol sip 

value 7XX command to modify. 

Step 3 Check the length of VU collected digits whether more than extension number. The length of 

VU collected digits as shown in Figure 3-10 is displayed. 

If yes, please modify the length of VU collected digits to intra-office number length. For 

example, the intra-office number is four, you can change the thirty-two to four. 

Figure 3-10 The length of VU collected digits 

 

 

 
You can obtain the VU script file in the release notes delivered with the product( that is Script file). 

Step 4 See 3.2 Only One Party Can Hear the Peer Voice Step 5 to check the device voice codec. 

Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.9 Sending and Collecting Digits Fail 

This topic describes how to troubleshoot a fault that causes failure to send and collect digits. 

Symptom 

Sending and collecting digits faults are as follows: 

 Two-stage dialing fails. 

 The voice prompt "Please input called number." is played all the time. 

 The dialed number is incorrect. 

 The connected user is not the user that the calling party calls. 

Possible Causes 

The possible causes are as follows: 

 The digit collection mode does not match that of the peer device. For example, one end 

uses the RFC2833 digit collection mode but the other end does not. 

 The digits that have been sent or received are incorrect. 
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Procedure 

Step 1 If the SoftCo uses the SIP trunk to connect to the peer device, check whether the SoftCo and 

the peer device use the same digit collection mode. 

Contact the peer engineer to check the digit collection mode and the value of PayloadTpye. If 

the RFC2833 digit collection mode is enabled on the peer device, perform the following 

operations on the SoftCo: 

1. Run the show cdsp argu command to view the digit collection mode. The RFC2833 

digit collection mode is disabled by default. This means that RFC2833Flag:0 is 

displayed. 

2. Run the config cdsp rfc2833switch <on|off> command in Config mode to enable the 

RFC2833 digit collection mode. 

3. Run the show cdsp payloadtype command to check whether the RFC2198 load (the 

value of PayloadTpye) is the same as that of the peer device. 

If the values are different, run the config cdsp payloadtype rfc2833 value<0-255> 

command in Config mode to change the value. 

Step 2 Capture logs by referring to 2.3 Log Analysis. Check whether the calling or called number 

that has been sent or received meets the specific requirement. For example, when an 

intra-office user initiates a call, the calling number transmitted to the Public Switched 

Telephone Network (PSTN) must be a long number. 

If the calling or called number does not meet the requirement, modify it by referring to 

SoftCo Product Document > Installation and Commissioning > Configure Voice Service 

(Command Line Mode) > Configuring Trunk Data > Configuring the Number Change. 

Step 3 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.10 Number Is Displayed Abnormally 

This topic describes a fault that causes number display abnormal. 

Symptom 

The number is displayed fault is as follows: 

 The number is displayed incorrectly. 

 The number cannot be displayed. 

Possible Causes 

The possible causes are as follows: 

 The Calling Line Identification Presentation (CLIP) service is enabled. This is, when the 

caller has CLIP service, the callee phone can not display the caller number. 

 The number change rule is incorrect. 
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Procedure 

Step 1 Run the show subscriber dn<string>type newservice command to check whether the user 

has enabled the Calling Line Identification Restriction (CLIR) service. (CLIR is not set by 

default.) 

If yes, run the config modify subscriber dn <string> operatenewservice del 

newservicerights clir command to delete the configuration.  

Step 2 Check whether the number change rule of the outgoing prefix is correct. 

1. Run the show prefix dn<string> command to check whether the outgoing prefix is 

configured with the number change rule. 

If yes, use the following command to check and modify the number change rule: 

− Run the show subscriber command to whether the user long number is correct (value 

of LongDn). If the configuration is incorrect, run the config modify subscriber dn 

<string> longdn <string> command to modify. 

− Run the show predeal index <0-1023> command to check whether the number 

change rule is correct. If the number change is incorrect, run the config modify 

predeal command to modify. 

− Run the show numbermap to check whether the number mapping is correct. If the 

number mapping is incorrect, run the config modify numbermap num <string> 

newexternnum <string> to modify. 

Figure 3-11 indicates configure the long nuber (The value of UseLongCLI is YES ), the 

number change (value of CLIPredeal Information) and the number mapping (value of 

NumberMap Information). 

Figure 3-11 Outgoing prefix number change 

 

 

2. Run the show tgld command to check whether the trunk bearer has been configured. The 

trunk bearer has been configured, as shown in Figure 3-12. 

If yes, skip to Step a.  
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Figure 3-12 Trunk bearer 

 

 

Step 3 See 2.3 Log Analysis to capture the log information, check whether the caller number and 

callee number match the peer requirement. For example, the intra-office user is caller user, 

you must send the long number to the PSTN. 

If no, modify it by referring to SoftCo Product Document > Installation and 

Commissioning > Configure Voice Service (Command Line Mode) > Configuring Trunk 

Data > Configuring the Number Change. 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

 
If the AT0 trunk is used for the connection, the calling number is displayed as a POTS number and 

cannot be changed. 

----End 

3.11 Voice Prompt Faults 

This topic describes how to troubleshoot voice prompt faults. 

Symptom 

Voice prompt faults are as follows: 

 When an intra-office user picks up the phone, no voice prompt can be heard, but the user 

hears the busy tone after a while. 

 When an intra-office user picks up the phone and dials the service number, there is no 

voice prompt or the voice prompt is incorrect. 

 When an outer-office user calls an intra-office user who is not in idle state, no voice 

prompt can be heard. The intra-office user hears the busy tone after a while. 

 When an outer-office user calls an intra-office user who is not in idle state, the voice 

prompt is incorrect. 

Possible Causes 

The possible causes are as follows: 

 The service configuration is incorrect. 
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 The Media Resource Unit (MRU) or Media Resource Server (MRS) on the SoftCo9500 

is defective. 

 Files in the voice.zip package on each board are not synchronized. 

 Files in the voice.zip package are incorrect. 

 The voice codec mode on the terminal does not match that on the SoftCo. 

 The peer device does not support the voice prompt function. 

Procedure 

Step 1 If only a service voice prompt is incorrect, check the service configuration. For details about 

the service configuration, see Services Configuration(CLI). 

Step 2 On the SoftCo9500, run the show board command to check whether the MRU and MRS are 

in OK state. 

If the MRU and MRS are in Fault state, proceed as follows: 

1. Log in to the MRU through the serial port and run the show version command to check 

whether the version of the MRU or MRS is the same as that of the MCU. For details on 

how to log in to the MRU through the serial port, see How to Connect to the SoftCo 

Through the Serial Port or by Telnet. 

If the version of the MRU or MRS is different from that of the MCU, see the SoftCo 

Upgrade Guide to upgrade the version. 

2. Remove and reinstall the MRU and MRS, or replace the MRU and MRS. 

Step 3 On the SoftCo9500, run the config download file voice slot<2-9> command to synchronize 

the voice.zip package on the MCU to the MRU and MRS. 

Step 4 Run the config upload file voice command to download the voice.zip file in Config mode. 

After the package is decompressed, check whether the .pcm file in the voice folder is correct. 

If the file is incorrect, obtain the voice folder from the software package, make the voice.zip 

file, and load it to the SoftCo. For details on how to make the voice.zip file, see VU Service. 

Step 5 See Step 5 in 3.2 Only One Party Can Hear the Peer Voice to check whether the IP phone, 

SoftCo, and IAD use the same codec. 

Step 6 Check whether the peer device supports the voice prompt function on the SoftCo. 

If the function is not supported, change the voice prompt to the error code prompt. 

1. Run the show softargu command to view the software parameter ID (the value of Type) 

of a particular voice prompt. 

[%SoftCo5816(config)]#show softargu   

  

All Arguments in SoftArgu Table  

  

Type Value     Meaning  

0    --        System max user number  

1    --        System max cpu ration    

...   

278  --        Way of SIPTK errcode indication[1:183(default) 0:errcode]//SIP trunk  

...     

307  --        Msg type for IMS[0:180(forward) 1: 183(Colorring)]//IMS  

308  --        Way of PRATK errcode indication[1:183(default) 0:errcode]//PRA trunk  
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...  

310  --        Way of R2TK errcode indication[1:183(default) 0:errcode]//R2 trunk 

2. Run the config softargu type<0-512>value 0 command in Config mode to change the 

voice prompt to the error code prompt (the default value is 1). 

 
If the ISUP or TUP trunk is used, run the config protocol isup officeno<0-254>sendabnormaltone 

<yes|no> command to change the voice prompt to the error code prompt. 

Step 7 Capture logs by referring to 2.3 Log Analysis. Check whether signaling interactions between 

trunks are correct. 

 If the error code or signal releasing is incorrect, check the data configuration. 

 If the data configuration is correct, contact engineers of the peer device. 

Step 8 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

3.12 Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

3.12.1 IAD User Cannot Be Called 

This topic describes how to troubleshoot a fault that occurs when an IAD user is called. 

Symptom 

User numbers on the SoftCo range from 801 to 806. An IAD user uses 801 and POTS users 

use 802 to 806. All users can call peer device users, but the peer device users cannot dial user 

number 801. 

Possible Causes 

Run the show prefix command to check the prefix information. The minimum number length 

is 4 and the maximum number length is 24. When a user dials 802#, the number length 

calculated by the user box is 4. The number length calculated by the IAD, however, is 3, 

which is smaller than the minimum number length. As a result, the IAD user cannot be called. 

Procedure 
 Run the config modify prefix dn 8 minlen 3 maxlen 24 command to modify the 

minimum number length. 

----End 

3.12.2 Connecting a Call from an IAD User to a Peer Device User 
Takes a Long Time 

This topic describes how to troubleshoot a fault that occurs when a call is connected from an 

IAD user to a peer device user. 
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Symptom 

When an IAD user calls a peer device user, the call takes up to 10 seconds to be connected. 

Possible Causes 

The way of number report on the SoftCo is not the same as the IAD. The software parameter 

corresponding to a number is enabled on the SoftCo. The IAD reports all numbers at one 

time. 

Procedure 

Step 1 Run the show softargu command to check value of the Type field corresponding to sip 

support iad no pond switch. 

[%SoftCo5816(config)]#show softargu   

  

All Arguments in SoftArgu Table  

  

Type Value     Meaning                                                               

---- --------- -------------------------------------------------------------------   

0    --        System max user number                                                

1    --        System max cpu ration   

...  

282  0x1       sip support iad no pond switch[1:(open) 0:close default:0]   

Step 2 Run the config softargu type<0-512>value 0 command to disable the software parameter sip 

support iad no pond switch. 

----End 

3.12.3 A Caller Hears the Voice Prompt That "The number you 
dialed does not exist" When Calling an Intra-Office User 

This topic describes how to troubleshoot a fault that a caller hears the voice prompt that "The 

number you dialed does not exist" when calling an intra-office user. 

Symptom 

Intra-office user A or external user C hears the voice prompt "The number you dialed does not 

exist" when calling intra-office user B. 

Possible Causes 

The intra-office prefix is not configure. 

Procedure 
 Run the config add prefix dn <string> callcategory basic callattribute inter minlen 0 

maxlen 8 command to configure the related prefix. 

----End 
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3.12.4 No User Can Make a Call 

This topic describes how to troubleshoot a fault that no user can make a call. 

Symptom 

No user on the SoftCo can call other intra-office or outer-office users. In addition, no 

outer-office users can call users on the SoftCo. 

Possible Causes 

Run the show billpool state command to check the number of bills is greater than 90% of the 

capacity. Call restriction on the full bill pool may be enabled. When this function is enabled, 

all the calls are restricted if the number of bills is greater than 90% of the capacity 

(SoftCo5816 capacity: 50,000 bills; SoftCo9500 capacity: 240,000 bills). 

Procedure 
 Run the debug debug_pid bill_server cmd 45 p1<0-4294967295>p2<0-4294967295> 

command to delete some bills so that the number of bills is less than 80% of the bill pool 

capacity. In the command, p1 indicates the start bill to be deleted and p2 indicates the 

number of bills to be deleted. You can delete bills multiple times. Command execution 

takes a long time. 

----End 

3.12.5 UA5000 Users Cannot Call Users Whose Number Prefix Is 
05370821 

This topic describes how to troubleshoot the fault that UA5000 users cannot call users whose 

number prefix is 05370821. 

Symptom 
 On the SoftCo, the outgoing prefix is set to 0 and number change is performed (the first 

digit of the called number is deleted). UA5000 users can call mobile users but cannot call 

fixed-line users whose number prefix is 05370821. 

 On the SoftCo, the outgoing prefix is set to 05370821 and number change is not 

performed. UA5000 users cannot call fixed-line users whose number prefix is 05370821. 

Possible Causes 

The default H.248 digitmap on the SoftCo does not match the actual dialing scheme. 

Procedure 

Step 1 Run the show digitmap command to check the default H.248 digitmap. 

Step 2 In Config mode, run the config delete digitmap protocol h248 command to delete the default 

digit map. 
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Step 3 In Config mode, run the config add digitmap protocol h248 name ua5000 value 

[FE]xxEx.F|[FE]xxF|ExxExx.Exx.F|ExxExx.Exx.Exx.F|EExx|Exxx|x command to add a 

digitmap that matches user's actual dialing requirement. 

----End 
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4 Trunk Faults 

About This Chapter 

Use different methods for troubleshooting faults on different trunks. 

4.1  Background 

This topic describes the background on trunks, which helps to troubleshoot faults. 

4.2  E1 Trunk Exception 

This topic describes how to troubleshoot E1 trunk exceptions. 

4.3  Call Fails on the PRA Trunk 

This topic describes how to troubleshoot a call fail that occurs on the PRA trunk. 

4.4  SIP Trunk Fault 

This topic describes common SIP trunk fault and how to troubleshoot the fault occurs on the 

SIP trunk. 

4.5  Call Fails on the SS7 Trunk 

This topic describes how to troubleshoot a call fails that occurs on the SS7 trunk. 

4.6  Call Fails on the AT0 Trunk 

This topic describes how to troubleshoot a call fails that occurs on the AT0 trunk. 

4.7  Call Fails on the R2 Trunk 

This topic describes how to troubleshoot a call fails that occurs on the R2 trunk. 

4.8  Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

4.1 Background 

This topic describes the background on trunks, which helps to troubleshoot faults. 
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4.1.1 E1 Trunk Cable 

This topic describes the SoftCo physical connection with the E1 trunk cable and common E1 

alarms. 

Physical Connection 

The SoftCo9500 is connected to the peer device with the E1 cable, as shown in Figure 4-1. 

Figure 4-1 Connecting the SoftCo9500 to the peer device with the E1 cable 

 

 

The SoftCo5816 is connected to the peer device with the E1 cable, as shown in Figure 4-2. 
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Figure 4-2 Connecting the SoftCo5816 to the peer device with the E1 cable 

 

 

 
Currently, the following cables are used: 

 E1 unbalanced cable with the transmission distance being about 200 m. 

 E1 balanced cable with the transmission distance being about 150 m. 

E1 Alarms 

E1 alarm types include: 

 Fault alarms 

A fault alarm is generated when the device is faulty. You must rectify the fault so that the 

system can be restored. Common fault alarms include: 

− Loss of signal (LOS) 

When a device cannot detect a signal, an LOS alarm is generated. When the device 

detects the signal, the LOS alarm is cleared. 

− Alarm indication signal (AIS) 

The peer device cannot correctly receive frame alignment signals. 

− Loss of frame alignment (LFA) 

An LFA alarm and an LOS alarm occur simultaneously. The LFA alarm is cleared 

after frame alignment. 

− Remote alarm indication (RAI): 

An RAI alarm indicates that the peer device cannot detect any signals. This may 

occur because the SoftCo fails to send signals, the SoftCo is disconnected, or the peer 

device fails to receive signals. 

 Event alarms 

Event alarms do not normally require any handling. Common event alarms include 

CRC4 error, BER of Frame Alignment>le-3, and SLIP. 

4.1.2 PRA Trunk 

The primary rate adaptation (PRA) trunk signaling process varies according to the user type. 
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Basic Concept 

Integrated Services Digital Network (ISDN) has two type of velocity: 

 Basic Rate Interface (BRI) 

It has two B channel and one D channel, this is 2B+D. The velocity of B channel are 64 

kbit/s which use to bear sound, image and data communication. The velocity of D 

channels are 16 kbit/s which uses to indicate the Public Switched Telephone Network 

how deal with the B channels. 

 Primary Rate Interface (PRI)  

It has 30B+D and 23B+D type. Both B channels and D channels are 64 kbit/s digital 

channels. Except for the United States, all countries use 30 B channels and one D 

channel. 

Signaling Process 

The signaling process varies according to the user type. 

 A POTS user in SoftCo calls a user in peer device, as shown in Figure 4-3. 

Figure 4-3 Normal signaling process for a call initiated by a POTS user 

 

 

The signaling process is described as follows: 

1. When an intra-office user calls an peer user, SoftCo sends a SETUP message to peer 

device, requesting to set up a call. 

2. Peer device sends a SETUPACKNOWLEDGE message, indicating that the call is being 

set up. 
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3. SoftCo sends an INFORMATION message with the information required for setting up 

the call(For example, caller number and callee number). 

4. Peer device sends an ALERT message, indicating that the phone of the peer user rings. 

5. Peer device sends a CONNECT message, indicating that the peer user picks up the 

phone. 

6. SoftCo sends a CONNECTACKNOWLEDGE message, indicating that the office user A 

has learned that the peer user has picked up the phone. 

7. The intra-office user starts to talk with the peer user. 

8. Peer device sends a RELEASE message, indicating that the peer user hangs up. 

9. SoftCo sends a RELEASECOMPLETE message, indicating that the intra-office user 

hangs up. SoftCo and peer device release channel resources. 

 A SIP user in SoftCo calls a user in peer device, as shown in Figure 4-4. 

Figure 4-4 Normal signaling process for a call initiated by a SIP user 

 

 

The signaling process is described as follows: 

1. When an intra-office user calls an peer user, SoftCo sends a SETUP message, requesting 

to set up a call. 

2. Peer device returns a CALLPROCEEDING message, indicating that the call is being set 

up. 

3. Peer device sends an ALERT message, indicating that the phone of the peer user rings. 

4. Peer device sends a CONNECT message, indicating that the peer user picks up the 

phone. 

5. SoftCo sends a CONNECTACKNOWLEDGE message, indicating that the intra-office 

has learned that the peer user has picked up the phone. 

6. The intra-office user starts to talk with the peer user. 

7. Peer device sends a RELEASE message, indicating that the peer user hangs up. 

8. SoftCo sends a RELEASECOMPLETE message, indicating that the intra-office user 

hangs up. SoftCo and peer device release channel resources. 
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If the intra-office user is callee user, the signaling process is oppositional. 

4.1.3 SIP Trunk 

This topic describes the basic concept and signaling process for the SIP trunk. 

Basic Concept 

Session Initiation Protocol (SIP) is a signaling control protocol at the application layer and is 

used to create, modify, and terminate two-party or multi-party sessions. Session Description 

Protocol (SDP) is used to describe multimedia communication sessions for session 

announcement and invitation, and multimedia session initialization. 

Signaling Process 

Figure 4-5 shows the normal signaling process. 

Figure 4-5 Normal signaling process 

 

 

The normal signaling process is as follows: 

1. When an intra-office user attempts to call an peer user, SoftCo sends an INVITE 

message to set up a call. 

2. Peer device sends a 180 Ringing message indicating that the peer user's phone is ringing. 

3. Peer device sends a 200 OK message indicating that the peer user has picked up the 

phone. 

4. SoftCo sends an ACK message indicating that the intra-office user is talking with the 

peer user. 

5. Peer device sends a BYE message indicating that the peer user has hung up. 

6. SoftCo sends a 200 OK message indicating that the intra-office user has been informed 

that the office user B has hung up. The intra-office user then hangs up. 

When the SoftCo functions as a device that initiates calls, common error codes are as follows: 

 488: indicates that the call cannot be connected. Check the media type supported by the 

peer device. 
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 486: indicates that the called party is busy. Check whether the terminal of the called 

party is configured with call transfer or whether the call is forwarded to a phone in busy 

state. 

 403: indicates that the call is rejected. The peer device does not pass authentication or the 

called number does not exist. 

 480: indicates a temporary fault. The call may expire. 

 400: indicates that the message format is incorrect. Check whether the message format 

can be identified by the peer device. 

 500: indicates that the server is faulty. Contact the peer device engineers. 

When the SoftCo functions as a device that receives calls, common error codes are as follows: 

 503: indicates that the CPU has reached the threshold and the system limits calls. 

 403: indicates that the trunk may be not configured or there is no call right. 

4.1.4 SS7 Trunk 

The SS7 trunk has different statuses and sustain the TUP and ISUP signaling. 

Trunk Circuit Status 

The trunk circuit status is described as follows: 

 IDLE                                      .  

 BUSY: Indicates that the circuit is being used. 

 UNKNOWN: Indicates that the circuit waits for the response of RSC and GRA 

messages. 

 FAULT: Indicates that the circuit is faulty because of incorrect configuration. 

 UNINSTALL: Indicates that the circuit is not configured. 

 AvailBlock: Indicates that the circuit can initiate calls only. 

 UnavailBlock: Indicates that the circuit can receive calls only. 

TUP signaling process 
 Figure 4-6 and Figure 4-7 show the normal signaling process. 
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Figure 4-6 Normal TUP signaling process (intra-office user first hangs up) 

 

 

Figure 4-7 Normal TUP signaling process (peer user first hangs up) 

 

 

The normal signaling process is as follows: 

1. When intra-office user calls peer user, SoftCo device sends an IAM message or an IAI 

message containing the information about initial address. 

2. SoftCo device sends an SAO message or an SAM message containing the information 

about peer user address. 

3. If other information is required for connecting the call, peer device sends a GRQ 

message requesting other information. 

4. After receiving the GRQ message, SoftCo device encapsulates the required information 

into a GSM message. Then the GSM message is sent. In this case, all the information 

required for establishing the call is collected. 



SoftCo VoIP Integrated Exchange  

Troubleshooting 4 Trunk Faults 

 

Issue 05 (2012-1-17) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

49 

 

5. Peer device locates the user according to the information and sends an ACM message. 

Intra-office user plays the RBT and peer user phone rings. 

6. After peer user picks up the phone, SoftCo device sends an ANC message indicating that 

peer user has picked up the phone.  

7. Intra-office user starts to talk with peer user. 

8. The mode of sending messages according to the hangup sequence.  

− If intra-office user first hangs up, SoftCo device sends a CLF message indicating that 

intra-office user has hung up. 

− If peer user first hangs up, peer device sends a CBK message indicating that peer user 

has hung up. Then intra-office user hangs up and sends a CLF message. 

9. Peer device sends an RLG message indicating that peer device is informed that 

intra-office user has hung up. 

 Figure 4-8 shows the call failure signaling process. 

Figure 4-8 TUP call failure signaling process 

 

 

When intra-office user fails to call peer user, peer device sends a message according to 

the user status.  

− If peer user number does not exist, peer device sends a UNN message to SoftCo 

device. 

− If peer user is busy, peer device sends an STB message or an SLB message to SoftCo 

device. 

ISUP signaling process 
 Figure 4-9 shows the normal ISUP signaling process. 
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Figure 4-9 Normal ISUP signaling process 

 

 

The normal ISUP signaling process is as follows: 

1. When intra-office user calls peer user, intra-office users sends an IAM message 

containing the information about peer user address. 

2. Peer device returns an INR message containing other information required for 

establishing the call. 

3. SoftCo device sends an INF message containing the information required for 

establishing the call. 

4. Peer user device locates the user according to the information and sends an ACM 

message. intra-office user plays the RBT and peer user phone rings. 

5. Peer user sends an ANM message indicating that peer user has hung up. 

6. Intra-office user starts to talk with peer user. 

7. If intra-office user first hangs up, SoftCo device sends an REL message indicating that 

intra-office user has hung up. 

8. peer device device sends an RLC message indicating that peer device is informed that 

intra-office user has hung up. 

 Figure 4-10 shows the call failure signaling process. 

Figure 4-10 ISUP call failure signaling process 

 

 

When intra-office user fails to call peer user, peer device sends an REL message. The 
REL message contains call failure causes. 
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4.1.5 AT0 Trunk 

This topic describes the basic concept of the AT0 trunk and incoming and outgoing calls 

through the AT0 trunk. 

The AT0 analog trunk is also called the loop trunk. With the AT0 trunk, the peer line can be 

used as the trunk line of the local device and the local device functions as the analog user. The 

number of peer lines determines the number of local trunks. The AT0 trunk uses DTMF 

signals and pulse signals (AT0_DTMF and AT0_PULSE) to transmit numbers. The 

maximum distance is 3 to 5 km. 

AT0 trunks are classified into outgoing trunks, incoming trunks, and bidirectional trunks. 

 AT0 outgoing trunk: A local user calls a peer user through the AT0 trunk. In this case, the 

AT0 trunk functions as the signal transmission channel. 

 AT0 incoming trunk: A peer user calls a local user through the AT0 trunk. In this case, 

the AT0 trunk receives and parses some analog signals and reports the results. 

4.1.6 R2 Trunk 

Channel associated signaling (CAS) indicates that the signaling and voice are transmitted in 

the same channel. R2 signaling is the CAS. 

Signaling Process 

An peer user (number 8000) calls an intra-office user (number 7000). Figure 4-11 shows the 

normal signaling process. 
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Figure 4-11 Normal signaling process 

 

 

The following describes the signaling process: 

1. An peer user calls an intra-office user. peer device sends a seizing signal. 

2. SoftCo returns a seizing-acknowledgement signal. 
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3. Soft Corequests the calling and called numbers from peer device, and then peer device 

sends the numbers to SoftCo. 

4. SoftCo sends status information about the intra-office user to peer device. 

5. If the peer user is available, SoftCo sends a response. 

6. The intra-office user talks with the peer user. 

7. The intra-office user hangs up. SoftCo sends a CALLEDHANDHOOK message. 

8. The peer user hangs up. peer device sends a CALLERHANDHOOK message. The talk 

ends. 

4.2 E1 Trunk Exception 

This topic describes how to troubleshoot E1 trunk exceptions. 

Symptom 

E1 trunk faults are as follows: 

 An LOS indicator light is on. 

 A frame slip alarm or an error code alarm is generated during signaling tracing with the 

Operation and Maintenance Unit (OMU). 

Possible Causes 

The possible causes are as follows: 

 The SoftCo is not grounded. 

 The clock sources at both ends are asynchronous. 

 The E1 trunk cable has failed. 

 The board has failed. 

 The peer device has failed. 

Procedure 

Step 1 Ensure that the SoftCo is grounded. 

Step 2 Run the show system clocksource information command to check whether the clock source 

is configured. 

If the clock source is not configured, as shown in Figure 4-12, run the configuration 

command. 

 SoftCo9500: config system clocksource primaryslot<2-9> primarye1<0-3> 

 SoftCo5816: config system clocksource primaryslot<1-4> primarye1<0-3> 
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Figure 4-12 Clock source not configured 

 

 

Step 3 Check whether the cable is correctly connected, and whether the cable is excessively long or 

damaged. 

1. Check whether the TX port of the SoftCo is connected to the RX port of the peer device. 

2. Check whether the cable is connected correctly or whether the connector is rusty. 

Reconnect or replace the E1 cable to check whether the fault has been rectified. 

3. Check whether the cable is excessively long according to the cable specifications. 

Usually, the E1 cable must be shorter than 150 m. The exact cable length limitation 

depends on the cable specifications. 

Step 4 Connect the TX port of the SoftCo to the RX port of the peer device, and check whether the 

LOS indicator on the board is off.  

If the indicator is still on, replace the board. 

Step 5 Contact the peer office's engineer to check whether the peer device is running normally. 

Step 6 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.3 Call Fails on the PRA Trunk 

This topic describes how to troubleshoot a call fail that occurs on the PRA trunk. 

Symptom 

The following faults often occur on the PRA trunk: 

 A busy tone is heard when an incomplete called number is dialed. 

 A busy tone is heard when a complete called number is dialed. 

Possible Causes 

The possible causes are as follows: 

 The E1 trunk cable is faulty or connected incorrectly. 

 The clock source is not configured. 

 The intra-office and outgoing prefixes are not configured. 

 The board status is abnormal. 

 The trunk circuit is faulty. 
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 The network positions (values of Position) do not match at both ends. 

 The CRC is enabled on one end, but is disabled on the other end. 

 The number which is sent by SoftCo do not meet the requirement of peer device. 

 Protocol versions do not match. North America and European standards are available for 

PRA trunks; Q.931is available for Layer 3 signaling protocol. 

Procedure 

Step 1 Check that the E1 trunk cable is normal and that the clock source is configured. For details, 

see 4.2 E1 Trunk Exception. 

Step 2 Run the show prefix callcategory basic command to check whether the intra-office and 

outgoing prefixes are configured. 

 If no, run the config add prefix command to configure. 

[%SoftCo9500(config)]#show prefix callcategory basic   

  

Prefix  

  

SubPBXNo Prefix CallAttribute OfficeSelectCode RegGroupId   

-------- ------ ------------- ---------------- ----------   

  

====  Command executed success !  ==== 

 If prefixes are configured, check that there are no conflicting prefixes.  

Step 3 Run the show board command on the SoftCo9500 or the show card command on the 

SoftCo5816 to check whether the DTU and MRU are in OK state. 

If the DTU and MRU are in FAULT state, proceed as follows to rectify the fault: 

1. Log in to the DTU or MRU through a serial port and run the show version command to 

check whether the version of the DTU or MRU is the same as that of the MCU. For 

details on how to log in to the DTU or MRU through a serial port, see How to Connect to 

the SoftCo Through the Serial Port or by Telnet.  

If the versions are different, see SoftCo Upgrade Guide to upgrade the DTU or MRU. 

2. Remove and reinstall, or replace the DTU and MRU. 

Step 4 Run the show tkc office no<0-254> command to check whether the trunk circuit status is 

IDLE (value of State). 

 If the circuit is in ISOLATE state, run the config cancelisolate board slot n<2-9> 

command on the SoftCo9500 or the config cancelisolate card slot<1-4> command on 

the SoftCo5816 to cancel board isolation. 

 If the circuit is in FAULT state, see SoftCo Product Document > Installation and 

Commissioning > Configure Voice Service (Command Line Mode) > Configuring 

Trunk Data > Configuring the PRA Trunk Interconnection Data to check whether 

the trunk data is correct. 

Step 5 Run the show pralink command to check whether the trunk link status is OK (value of State). 

which indicates that the link status is normal. 

If the value of State is FAULT, check link configuration. 

 The network position (value of Position) of one end must match that of the peer device. 

That is, when one end is the network side, the other end must be the user side. The 
SoftCo is configured as the user side.  
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 The timeslot (value of TS) of PRA links and the timeslot of the peer device must both be 

16.  

If the configuration is not correct, run the config modify pralink linkno <0-255> slot 

ntrunkport n position <user|network> ts <0-31> command to modify. 

Step 6 Check whether the RFA indicator on a board is on. 

If yes, check whether the CRC is enabled on the peer device. If no, run either of the following 

commands to enable the CRC on the SoftCo: 

 For the SoftCo9500, run config modify board slot<2-9> type dtu trunkport<0-3> 

officeno<0-254> crc4flag yes. 

 For the SoftCo5816, run config modify card slot <1-4> type dtu trunkport<0-3> 

officeno<0-254> crc4flag yes. 

Step 7 See 2.4 Signaling Analysis trace the signaling to check the call fail reason and deal with the 

fault. 

1. When intra-office calls external user, check whether the SoftCo sends a SETUP message 

to the peer device, as shown in Figure 4-13. 

 If no, check whether the PRA trunk configuration is correct. 

 If yes, check the content of the SETUP message. Verify that the calling number sent from 

the SoftCo to the peer device meets the requirements of the peer device. 

Set the value of uselongcli to yes (displaying the long number of the calling party on the 

phone of the called party) or change the calling number. See SoftCo Product 

Document > Installation and Commissioning > Configure Voice Service (Command 

Line Mode) > Configuring Trunk Data > Configuring the Number Change to 

configure the data. 

Figure 4-13 SETUP message 

 

 

2. When intra-office calls external user, check whether the calling/called number type and 

numbering plan in the SETUP message meet the requirements of the peer device. The 

Type of number indicates the number type and the Numbering plan identification 

indicates the numbering plan in the Figure 4-13. If no, proceed as follows to modify the 

configuration: 

 Use software parameters to modify the numbering plan. 

a. Run the show softargu command to check the value of Tpye field corresponding to 

PRA NumberPlan Identification. 

[%SoftCo5816(config)]#show softargu   

  

All Arguments in SoftArgu Table  
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Type Value     Meaning  

---- --------- -----------------------  

0    --        System max user number  

1    --        System max cpu ration  

...  

257  --        PRA NumberPlan Identification  

b. Run the config softargu type<0-512>value<value> command to modify the 

numbering plan. The type parameter indicates the software parameter ID. The 

values of <value> are as follows:  

− 0: unknown numbering plan 

− 1: ISDN telephony numbering plan 

− 3: data numbering plan 

− 4: telegraph numbering plan 

− 8: national standard numbering plan 

− 9: private numbering plan 

− 14: false calling line numbering plan 

− 15: reserved for expansion 

 Run the config protocol pra 

officeno<0-254>typeofcldnumber<value1>typeofclinumber<value2> command to 

configure the number type. The value1 parameter indicates the called number type; the 

value2 parameter indicates the calling number type. The types are as follows: 

− unknown: unknown number 

− international: international number 

− national: national number 

− networkspecific: network-specific number 

− subscriber: subscriber number 

− in: intelligent number 

− abbreviated: abbreviated number 

− reservedforextension: reserved for expansion 

− default: default type 

3. When external user calls intra-office, check whether the format of the SETUP message 

sent by the peer device is correct and whether the SETUP message carries the called 

number information. If no, contact the peer device engineers. 

Step 8 Contact the peer engineer to check whether the protocol version of peer device match the 

SoftCo. 

Step 9 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.4 SIP Trunk Fault 

This topic describes common SIP trunk fault and how to troubleshoot the fault occurs on the 

SIP trunk. 
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4.4.1 Call Fails on the SIP Trunk 

This topic describes how to troubleshoot a call fails that occurs on the SIP trunk. 

Symptom 

The following faults often occur on the SIP trunk: 

 A busy tone is heard when an incomplete called number is dialed. 

 A busy tone is heard when a complete called number is dialed. 

Possible Causes 

The possible causes are as follows: 

 The intra-office and outgoing prefixes are not configured. 

 The trunk data is not configured. 

Procedure 

Step 1 Check that the intra-office and outgoing prefixes are configured. For details, see Step 2 in 4.3 

Call Fails on the PRA Trunk. 

Step 2 Run the show protocol sip command to check whether the trunk data is configured. 

If no, run the config protocol sip officeno<0-254> domainname <string> peerport 
<0-6000> maxcallnum <1-240> command to configure the trunk data. 

[%SoftCo9500(config)]#show protocol sip  

  

SIP  

  

Office IPAddress DomainName LocolUdpPort LocolTcpPort PeerPort TransportType MaxCallNum   

------ --------- ---------- ------------ ------------ -------- ------------- ----------   

DefaultCLDNum1 DefaultCLDNum2 CallerPhoneContext CalleePhoneContext DeviceType OTMN   

-------------- -------------- ------------------ ------------------ ---------- ----   

SupportInfo CRBT SupportCliPredeal ImsConnId   

----------- ---- ----------------- ---------   

  

====  Command executed success !  ==== 

Step 3 See 2.4 Signaling Analysis to trace signaling process, check the call fail reason and deal with 

the fault. 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.4.2 Call Interrupts on the SIP Trunk 

This topic describes how to troubleshoot a call interrupts that occurs on the SIP trunk. 

Symptom 

During The SoftCo user call the peer device user, the call is interrupted suddenly. 
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Possible Causes 

The possible causes are as follows: 

 Multiple SIP terminals are registered with the same account. 

 A heartbeat connection has not been established. 

 The peer device is abnormal. 

Procedure 

Step 1 Check whether multiple SIP terminals are registered with the same account. 

If yes, quit the other SIP terminals. 

Step 2 Check whether the peer device supports the session heartbeat function.  

If no, run the config modify sip parameter usesessiontimer no command to disable the 

session heartbeat function. 

Step 3 Contact the peer office's engineer to check whether the peer device is running normally. 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.4.3 Fail to Call an IMS User Through the SIP Trunk 

An IMS user cannot be called through the SIP trunk. 

Symptom 

When calling the IMS user, the intra-office user hears the busy tone. 

Possible Causes 

The possible causes are as follows: 

 The registration group configuration is incorrect. 

 The calling number format does not meet IMS (86+area code+number) requirements. 

 The registration group ID is not set. 

Procedure 

Step 1 Run the show reggroup command to check whether the value of Status is OK. 

If no, check whether the IMPI field, IMPU field and Password field match the configuration 

of IMS. 

[%SoftCo9500(config)]#show reggroup   

  

 Register group   

  

Id IMPI                             IMPU                             Password Expires(*s)   

-- -------------------------------- -------------------------------- -------- 

-----------   

1  +862083785000@guangdong.test.com +862083785000@guangdong.test.com 111      300           
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2  +862083785001@guangdong.test.com +862083785001@guangdong.test.com 111      300           

Status   

------   

FAULT    

FAULT    

  

------- Matched record number : [9] ------- 

Step 2 Run the show prefix command to check whether the calling number change configuration of 

the prefix meets IMS requirements. 

If no, see SoftCo Product Document > Installation and Commissioning > Configure Voice 

Service (Command Line Mode) > Configuring Trunk Data > Configuring the Number 

Change to configure the data. 

Step 3 Run the show subscriber command to check whether the registration group ID (that is, 

RegGroupId) corresponding to the user is set. The registration group ID is set, as shown in 

Figure 4-14. 

If no, run the config modify subscriber dn <string> reggroupid <0-1600> command to 

change the value of RegGroupId. 

Figure 4-14 User registration group 

 

 

 
If users on other trunks connected to the SoftCo call IMS users, run the show office user command to 

check whether the value of RegGroupId is set. 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.4.4 IMS Users Cannot Be Invited to Join a Conference Through 
the SIP Trunk 

IMS users cannot be invited to join a conference through the SIP trunk. 
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Symptom 

The SoftCo fails to invite IMS users to join a conference. 

Possible Causes 

The possible causes are as follows: 

 The registration group password or account is incorrect. 

 The calling number format does not meet IMS (86+area code+number) requirements. 

 The registration group ID is not added to the outgoing calling number of the conference. 

Procedure 

Step 1 Use the show reggroup command to check whether the value of Status is OK. 

If no, check whether the IMPI field, IMPU field and Password field match the configuration 

of IMS. 

[%SoftCo9500(config)]#show reggroup   

  

 Register group   

  

Id IMPI                             IMPU                             Password Expires(*s)   

-- -------------------------------- -------------------------------- -------- 

-----------   

1  +862083785000@guangdong.test.com +862083785000@guangdong.test.com 111      300           

2  +862083785001@guangdong.test.com +862083785001@guangdong.test.com 111      300           

Status   

------   

FAULT    

FAULT    

  

------- Matched record number : [9] ------- 

Step 2 Run the show prefix command to check whether the calling number change configuration of 

the prefix meets IMS requirements. 

If no,  see SoftCo Product Document > Installation and Commissioning > Configure 

Voice Service (Command Line Mode) > Configuring Trunk Data > Configuring the 

Number Change to configure the data. 

Step 3 Use the show subpbx command to check whether the outgoing calling number (OutConfDn) 

and the registration group ID (RegGroupID) of the conference are set. The outgoing calling 

number and registration group ID are set, as shown in Figure 4-15. 

If no, run the config modify subpbx no <0-251> outconfdn <string> reggroupid 
<0-1600> command to modify the values of OutConfDn and RegGroupID. 
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Figure 4-15 User registration group 

 

 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.5 Call Fails on the SS7 Trunk 

This topic describes how to troubleshoot a call fails that occurs on the SS7 trunk. 

Symptom 

The following faults often occur on the SS7 trunk: 

 A busy tone is heard when an incomplete called number is dialed. 

 A busy tone is heard when a complete called number is dialed. 

Possible Causes 

The possible causes are as follows: 

 The E1 trunk cable is faulty or connected incorrectly. 

 The clock source is not configured. 

 The intra-office and outgoing prefixes are not configured. 

 The board status is abnormal. 

 The trunk circuit is faulty. 

 The trunk link status is faulty. 

Procedure 

Step 1 Check that the E1 trunk cable is normal and that the clock source is configured. For details, 

see 4.2 E1 Trunk Exception. 

Step 2 Check whether the intra-office and outgoing prefixes are configured and whether the board 

status is normal. For details, see step 2 and step 3 in 4.3 Call Fails on the PRA Trunk. 

Step 3 Check whether the trunk circuit is faulty. 

Run the show tkc office no<0-254> command to check whether check whether the trunk 

circuit status is IDLE (value of State). 
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 If the circuit is in FAULT state, see SoftCo Product Document > Installation and 

Commissioning > Configure Voice Service (Command Line Mode) > Configuring 

Trunk Data > Configuring the ISUP/TUP Trunk Interconnection Data to check 

whether the trunk data is correct. 

 If the circuit is in UNINSTALLED state, see SoftCo Product Document > Installation 

and Commissioning > Configure Voice Service (Command Line Mode) > 

Configuring Trunk Data > Configuring the ISUP/TUP Trunk Interconnection Data 

to configure. 

Step 4 Run the show mtplink command to check whether the trunk link status is OK (value of 

State). 

 If no, reset or replace the board to troubleshoot the fault. 

Step 5 See 2.4 Signaling Analysis to trace signaling process, check the call fail reason and deal with 

the fault. 

Step 6 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.6 Call Fails on the AT0 Trunk 

This topic describes how to troubleshoot a call fails that occurs on the AT0 trunk. 

Symptom 

The following faults often occur on the AT0 trunk: 

 A (SoftCo user) is unable to call B (peer device user). 

 B is unable to call A. 

Possible Causes 

The possible causes are as follows: 

 The intra-office and outgoing prefixes are not configured. 

 The board status is abnormal. 

 The SoftCo is not grounded. 

 The FXS port is abnormal. 

 The AT0 trunk circuit is faulty. 

 The AT0 trunk line is abnormal. 

Procedure 

Step 1 Check whether the intra-office and outgoing prefixes are configured and whether the board 

status is normal. For details, see step 2 and step 4 in 4.3 Call Fails on the PRA Trunk. 

Step 2 Check whether the SoftCo is grounded. 

Step 3 Check whether indicators on the ATU are normal. For details about indicators, see 2.2 Alarm 

Analysis. 

Step 4 Check whether the FXS port connected to the ATU is normal. 
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Disconnect the ATU from the FXS port and connect the POTS phone to the FXS port to check 

whether the call can be connected. If no, replace the FXS port. 

Step 5 Check whether the AT0 trunk circuit is faulty. 

Run the show tkc slot<2-9> command on the SoftCo9500 or the show tkc slot<1-4> 

command on the SoftCo5816 to check the trunk circuit status. 

 If the circuit is in ISOLATE state, run the config cancelisolate board slot<2-9> 

command on the SoftCo9500 or the config cancelisolate card slot<1-4> command on 

the SoftCo5816 to cancel board isolation. 

 If the circuit is in FAULT state, go to Step 6. 

Step 6 Check whether the AT0 trunk line is normal. 

Connect the phone to the AT0 trunk line and call users of the peer device. If calls to multiple 

users cannot be connected, contact the peer device engineers. 

Step 7 Check whether the ATU is faulty by using the OMU. If yes, check whether the ATU is 

installed. 

 
You can obtain the OMU from http://support.huawei.com. For details on how to use the OMU, see OMU 

Client Help.  

Step 8 If the fault persists, please obtain 1.6 Technical Support. 

----End 

4.7 Call Fails on the R2 Trunk 

This topic describes how to troubleshoot a call fails that occurs on the R2 trunk. 

Symptom 

The following faults often occur on the R2 trunk: 

 A busy tone is heard when an incomplete called number is dialed. 

 A busy tone is heard when a complete called number is dialed. 

Possible Causes 

The possible causes are as follows: 

 The E1 trunk cable is faulty or connected incorrectly. 

 The clock source is not configured. 

 The intra-office and outgoing prefixes are not configured. 

 The board status is abnormal. 

 The trunk circuit is faulty. 

 The register type is not MFC. 

 The R2 adaptation script is not imported. 
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Procedure 

Step 1 Check that the E1 trunk cable is normal and that the clock source is configured. For details, 

see 4.2 E1 Trunk Exception. 

Step 2 Check whether the intra-office and outgoing prefixes are configured and whether the board 

status is normal. For details, see step 2 and step 3 in 4.3 Call Fails on the PRA Trunk. 

Step 3 Run the show tkc office no<0-254> command to check whether the trunk circuit status is 

IDLE (value of State). 

 If the circuit is in ISOLATE state, run the config cancelisolate board slot<2-9> 

command on the SoftCo9500 or the config cancelisolate card slot<1-4> command on 

the SoftCo5816 to cancel board isolation. 

 If the circuit is in FAULT state, see SoftCo Product Document > Installation and 

Commissioning > Configure Voice Service (Command Line Mode) > Configuring 

Trunk Data > Configuring the R2 Trunk Interconnection Data to check whether the 

trunk data is correct. 

Step 4 Run the show cassignal command to check whether the register type is MFC(value of 

RegisterType). 

If no, run the config modify cassignal casname <string> registertype mfccommand to 

modify the register type. 

Step 5 Check whether the R2 adaptation script has been imported. 

Run the following command to check whether the R2 adaptation script has been imported: 

show line send id <0-254>  

show line report id <0-254>  

show register send id <0-254>  

show register report id <0-254>  

 

Check whether the number of displayed lines is the same as that of command lines 

corresponding to the script. If no, delete the configuration and re-import the adaptation script. 

To delete the configuration, run the following commands: 

config delete line send id <0-254>  

config delete line report id <0-254>  

config delete register send id <0-254>  

config delete register report id <0-254>  

 

Step 6 See 2.4 Signaling Analysis to trace signaling process, check the call fail reason and deal with 

the fault. 

Step 7 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

4.8 Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 
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4.8.1 Clock Source Configuration Fault 

If the clock source is incorrectly configured, exceptions will occur, for example, noise and 

frame slip. 

Symptom 

SoftCo A is connected to SoftCo B through the Primary Rate Adaptation (PRA) trunk. There 

are noises during a call or when you dial *125 to query a number. A frame slip alarm is 

reported when you use the Operation and Maintenance Unit (OMU) to analyze alarms. 

Possible Causes 

SoftCo A synchronizes time to SoftCo B and SoftCo B synchronizes time to SoftCo A, 

resulting in a failure to synchronize the clock sources. 

Procedure 

Step 1 If SoftCo A is connected to the carrier's network through the PRA trunk, change the SoftCo A 

clock source, and use the carrier's time. 

Proceed as follows to modify the clock source: 

 Run the config system clocksource primaryslot<2–9>primarye1<0–3> command in 

Config mode on the SoftCo9500. 

 Run the config system clocksource primaryslot<1–4>primarye1<0–3> command in 

Config mode on the SoftCo5816. 

Step 2 If SoftCo A is connected to the carrier's network through the Session Initiation Protocol (SIP) 

trunk, run the config system clocksource oscillator command in Config mode to change the 

SoftCo A clock source to the default time. 

 
The IMS is connected to SoftCo through the SIP trunk. The Online Charging System (OCS) is connected 

to the SoftCo through the SIP trunk, and the SoftCo functions as an intermediate device. The SoftCo 

clock source uses the default time. 

----End 

4.8.2 Calling a PSTN User Through the PRA Trunk Fails 

This topic describes how to troubleshoot a fault occurring when a PSTN user is called through 

the PRA trunk. 

Symptom 

The SoftCo is connected to the PSTN through the PRA trunk. The SoftCo boards and the PRA 

trunk link are running properly. A PSTN user can call a intra-office user, but the intra-office 

user cannot call the PSTN user. 

Possible Causes 

Use the UCMaint to analyze the logs. The values of Numbering plan identification and 

Number digits in the SETUP message when the intra-office user is the calling party are found 
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to be different from those when the PSTN user is the calling party, as shown in Figure 4-16 

and Figure 4-17. 

Figure 4-16 Values displayed when the PSTN user functions as the calling party 

 

 

Figure 4-17 Values displayed when the SoftCo user functions as the calling party 

 

 

Procedure 

Step 1 Run the show prefix dn 9 command to check the outgoing prefix attributes. As shown in 

Figure 4-18, the calling number change attribute is not configured for the outgoing prefix and 

the value of UselongCLI is NO. 
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Figure 4-18 Outgoing prefix attributes 

 

 

Step 2 Run the config add predeal index 5 changetype modify changepos 0 changelen 24 newdn 

700 command to configure the number index. 

Step 3 Run the config modify prefix 9 clipredeal yes cliindex 5 uselongcli yes command to modify 

the outgoing prefix attributes so that the calling number meets PSTN requirements. 

Step 4 Run the show softargu command to check the Type field corresponding to PRA 

NumberPlan Identification. The software parameter ID corresponding to PRA 

NumberPlan Identification is 257. 

Step 5 Run the config softargu type 257 value 1 and config protocol pra officeno 0 

typeofcldnumber unknown typeofclinumber national commands to modify the numbering 

scheme. 

----End 

4.8.3 Prompts for the Extension Number or a User Hears the Busy 
Tone When the User Makes a Call to the Main Number Through 
the AT0 Trunk 

This topic describes how to troubleshoot a fault that occurs when a user makes a call to the 

main number through the AT0 trunk. 

Symptom 

The SoftCo is connected to the peer device through the AT0 trunk. The peer device user dials 

the main number, the system prompts for the extension number. The user dials the extension 

number, but the system continues to prompt for the extension number. 

Possible Causes 

The SoftCo fails to detect signals because the AT0 line is too long. 

Procedure 
 Increase the AT0 incoming gain (adgain). The default AT0 incoming gain is 6. 
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− If the AT0 trunk interface provided by the SoftCo5816 chassis is used, run the config 

modify at0tkc mpu portinboard 0-7 adgain <0-12> command. 

− If the AT0 trunk interface provided by the SoftCo5816 board is used, run the config 

modify at0tkc card slot <1-4> portinboard 0-7 adgain <0-12> command. 

− If the AT0 trunk interface provided by the SoftCo9500 board is used, run the config 

modify at0tkc slot <2-9> portinboard 0-7 adgain <0-12> command. 

----End 

4.8.4 Connecting a Call on the AT0 Trunk Takes a Long Time 

This topic describes how to troubleshoot a fault occurring when a call is being connected on 

the AT0 trunk. 

Symptom 

The SoftCo is connected to the peer device through the AT0 trunk. A intra-office user calls a 

peer device user. The intra-office user hears the ring back tone (RBT) after a long delay (10 

seconds or more). 

Possible Causes 

The intra-office user use the direct-dialing-in(DDI) service. Therefore, connecting a call takes 

a long time. You are advised to change the dialing mode to two-stage dialing. 

Procedure 
 Run the config modify office selectcode no <0-254> send2nddialtone yes command to 

change the dialing mode to two-stage dialing. 

----End 

4.8.5 Calling Number Is Not Displayed for an AT0 Trunk Call 

This topic describes how to troubleshoot a fault occurring when a call is made through the 

AT0 trunk. 

Symptom 

The SoftCo is connected to the PSTN through the AT0 trunk. When a PSTN user calls a 

SoftCo user, the calling number is not displayed. 

Possible Causes 

The possible causes are as follows: 

 The calling line identification presentation (CLIP) service has not been enabled for the 

SoftCo user. 

 The SoftCo fails to detect signals because the AT0 line is too long. 

 The peer device sends calling numbers using dual tone multi-frequency (DTMF) signals, 

but the SoftCo supports only frequency shift keying (FSK) signals. 
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Procedure 

Step 1 Check whether the CLIP service is enabled for the SoftCo user. If the CLIP service is not 

enabled, ask the user to subscribe to the CLIP service. 

Connect the phone to the AT0 trunk interface provided by the carrier to check whether the 

calling number is displayed. If yes, the CLIP service is enabled. 

Step 2 Check whether FSK signals are used. 

 If the calling number is displayed when an incoming call is received, it indicates that 

DTMF signals are used. In this case, contact peer office engineers. 

 If the calling number is displayed between the first ring and the second ring, it indicates 

that FSK signals are used. 

Step 3 Increase the AT0 incoming gain (adgain). The default AT0 incoming gain is 6. 

 If the AT0 trunk interface provided by the SoftCo5816 chassis is used, run the config 

modify at0tkc mpu portinboard 0-7 adgain <0-12> command. 

 If the AT0 trunk interface provided by the SoftCo5816 board is used, run the config 

modify at0tkc card slot <1-4> portinboard 0-7 adgain <0-12> command. 

 If the AT0 trunk interface provided by the SoftCo9500 board is used, run the config 

modify at0tkc slot <2-9> portinboard 0-7 adgain <0-12> command. 

Step 4 If the fault persists, contact Huawei customer service center or the local office. 

----End 

4.8.6 Called Party Cannot Hear the Busy Tone After the Calling 
Party Hangs Up on an AT0 Trunk Call 

This topic describes how to troubleshoot a fault occurring when the calling party hangs up on 

an AT0 trunk call. 

Symptom 

The SoftCo is connected to the PSTN through the AT0 trunk. Assume that a PSTN user 

initiates a call to a SoftCo user. After the PSTN user hangs up, the SoftCo user cannot hear the 

busy tone. 

Possible Causes 

The possible causes are as follows: 

 Configuration on the carrier side is incorrect. As a result, the system fails to send busy 

tone signals after the calling party hangs up. 

 The SoftCo fails to detect signals because the AT0 line is too long. 

Procedure 

Step 1 Connect the phone to the AT0 trunk interface provided by the carrier and call the SoftCo user 

using the PSTN number. Hang up after the call is connected. Then check whether the called 

party hears the busy tone. If no, contact peer office engineers. 

Step 2 Increase the AT0 incoming gain (adgain). The default AT0 incoming gain is 6. 
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 If the AT0 trunk interface provided by the SoftCo5816 chassis is used, run the config 

modify at0tkc mpu portinboard 0-7 adgain <0-12> command. 

 If the AT0 trunk interface provided by the SoftCo5816 board is used, run the config 

modify at0tkc card slot <1-4> portinboard 0-7 adgain <0-12> command. 

 If the AT0 trunk interface provided by the SoftCo9500 board is used, run the config 

modify at0tkc slot <2-9> portinboard 0-7 adgain <0-12> command. 

Step 3 If the fault persists, contact Huawei customer service center or the local office. 

----End 

4.8.7 Call Fails When the Mobile User Calls the Intra-office 
Analog User on the AT0 Trunk 

This topic describes how to troubleshoot a call fails when the mobile user calls the intra-office 

analog user on the AT0 trunk. 

Symptom 

The SoftCo is connected to the carrier through the AT0 trunk. When the mobile user calls the 

intra-office analog, the incoming call displays 000. When the mobile uses hangs up, the 

intra-office analog rings all the time. 

Possible Causes 

The AT0 line is interrupted the environment, then the SoftCo can not detect the analog signal. 

Procedure 

Step 1 Check whether the SoftCo is grounded. 

Please remove and reinstall the PGND cables to deal with the fault.  

Step 2 Connect analog user cable of the carrier or the ATU board on the SoftCo to the grounding 

terminal, which used to clear the environment interruption. 

Figure 4-19 indicate the SoftCo uses the PGND cables to connect the analog user cable to the 

grounding terminal. 
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Figure 4-19 Grounding connection 

 

 

Step 3 If the fault persists, contact Huawei customer service center or Huawei local offices. 

----End 

4.8.8 Calls Made Through the AT0 Trunk Are Always Connected 
to the Same Number 

This topic describes how to troubleshoot the following fault: When a user calls any SoftCo 

number, the same phone rings. 

Symptom 

The SoftCo is connected to the peer device through the AT0 trunk. When a user calls any 

SoftCo number, the same phone rings. 

Possible Causes 

Run show protocol at0 officeno <0-254> command discovering the defaultcldnum1 field 

has value. The trunk is configured with the default incoming number. 

Procedure 
 Run the config protocol at0 officeno <0-254> defaultcldnum1 0000 command to 

delete the default AT0 incoming number. 

----End 
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4.8.9 Fault Occurs When a Moderator Invites a User to Join a 
Conference Call Through the AT0 Trunk 

This topic describes how to troubleshoot a fault that occurs when a moderator invites a user to 

join a conference call through the AT0 trunk. 

Symptom 

The SoftCo is connected to the peer device through the AT0 trunk. When a moderator invites 

a user to join a conference call, only part of the called number is displayed on the conference 

management page because the dialing speed is low. 

Possible Causes 

By default, the SoftCo uses a timer to specify the time for the AT0 module to send a Connect 

message. If the time set on the timer runs out when a SoftCo user calls a peer device user, the 

AT0 module sends a Connect message to the calling device regardless of whether the dialing 

is complete. The remaining digits are sent through voice, and they are not recorded by the 

SoftCo. Therefore, if the moderator dials slowly, the number in the Connect message may be 

incomplete.  

Procedure 
 Run the config at0 sendremoteoffhook condition pole command to change the control 

mode. 

 
The fault can be rectified if the peer device supports polarity reversal signals. If the peer device does not 

support polarity reversal signals, users must dial a number consecutively. 

----End 

4.8.10 Simultaneous/Sequential Ringing Service Cannot Be Used 
When a User Number of the Peer Device Connected to the AT0 
Trunk Is Used for the Service 

This topic describes how to troubleshoot a fault that occurs when a user number of the peer 

device connected to the AT0 trunk is used for the simultaneous ringing service or sequential 

ringing service. 

Symptom 

The SoftCo is connected to the peer device through the AT0 trunk. When a peer device user 

number is used for the simultaneous ringing service or sequential ringing service, the 

simultaneous ringing service or sequential ringing service cannot be used. 

Possible Causes 

When a user makes an outgoing call through the AT0 trunk, the SoftCo starts the timer by 

default during the dialing. When the time set on the timer runs out, the AT0 trunk sends a 

Connect message to the calling device regardless of whether the dialing is complete. If the 

simultaneous ringing service or sequential ringing service is enabled, the system assumes that 
the called party picked up the phone, resulting in the fault. 
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Procedure 
 Run the config at0 sendremoteoffhook condition pole command to change the control 

mode. 

 
The fault can be rectified if the peer device supports polarity reversal signals. If the peer device does not 

support polarity reversal signals, users must dial a number consecutively. 

----End 
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5 Service faults 

About This Chapter 

The troubleshooting method varies according to service category. 

5.1  Background 

This topic describes the background on supplementary service, which helps to troubleshoot 

faults. 

5.2  Call Forwarding Faults 

This topic describes how to troubleshoot call forwarding faults. 

5.3  Transfer Service Faults 

This topic describes how to troubleshoot call transfer service faults. 

5.4  ONLY Service Faults 

This topic describes the common One Number Link You (ONLY) service fault and how to 

troubleshoot the One Number Link You (ONLY) service faults. 

5.5  Main Number Service Fault 

This topic describes the common main number service and how to troubleshoot the main 

number service fault. 

5.6  Fax service fault 

This topic describes the common main number service and how to troubleshoot the fax 

service fault. 

5.7  Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

5.1 Background 

This topic describes the background on supplementary service, which helps to troubleshoot 

faults. 
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5.1.1 Call Forwarding/Transfer Service 

Before using forwarding services, pay attention to priorities of forwarding services. 

If a call forwarding service is enabled, all calls are automatically forwarded to a preset 

number regardless of the called party status. 

When using call forwarding services, pay attention to the following points: 

 Call Forwarding Unconditional (CFU) service: The CFU service conflicts with the 

following services: Do-Not-Disturb (DND) service, alarm clock service, absent user 

service, instant hotline service, call waiting service, and call back on busy (CBB) service. 

The CFU service takes precedence over the Call Forwarding No Reply (CFNR) service 

and the Call Forwarding Busy (CFB) service. 

 CFNR service: The CFNR service conflicts with the following services: DND service, 

alarm clock service, absent user service, instant hotline service, and CBB service. The 

priority of the CFNR service is lower than that of the call waiting service. 

 CFB service: The CFB service conflicts with the following services: DND service, alarm 

clock service, absent user service, instant hotline service, call waiting service, and CBB 

service.  

 Call Forwarding Offline (CFO) service: The priority of the CFO service is lower than 

that of the DND service. 

If the call transfer service is enabled, a user can transfer a call to a third party by pressing the 

hookflash key during a conversation. The user then automatically quits the conversation. By 

default, SoftCo users have been assigned the right to transfer calls. 

5.1.2 ONLY Service 

If you use ONLY service, please pay attention to conflict other service. 

In the one number link you (ONLY) service, multiple terminals share the same number and 

supplementary services. The shared number is the number of an intra-office terminal, and is 

called the ONLY number. The intra-office terminal is the primary terminal and can be 

specified by the subscriber. When other subscribers dial the ONLY number of the subscriber, 

the terminals of the subscriber ring according to the preset rules, and the subscriber can select 

a terminal to answer the phone. 

The number of the primary terminal has the ONLY service right. Otherwise, the administrator 

needs to configure the ONLY service right for the number. In addition, the administrator needs 

to bind one or more other terminals to the number of the primary terminal so that the number 

can be shared by multiple terminals. 

 
 The priority is : Service of Call Forwarding Unconditional > Services of Call on Busy > Sequential 

Ringing Service > ONLY Service > Service of Call Forwarding No Reply. You should delete other 

service which conflict with ONLY service when you give priority to ONLY service. 

 If the last user of sequential ringing refuse the call, the caller can heard the prompt voice. 

5.1.3 Fax 

This topic describes the basic problem about fax. 

 Identification 

Determining whether a fax machine is a sender or a recipient depends on whether there 
are papers in the paper tray. 
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− If there are papers in the paper tray, the fax machine is the sender. If there is no paper 

in the paper tray, the fax machine is the recipient. 

− If there are papers in the paper trays of both machines, both machines consider 

themselves as the sender, causing fax failures. 

− If there is no paper in either paper tray, both fax machines consider themselves as the 

recipient, causing fax failures. 

 Fax mode selection 

Usually, fax machines support the following modes: FAX/TEL, FAX ONLY, and 

MANUAL. Select a mode as required. 

− FAX/TEL: applicable to the situation that the fax machine is sometimes used as a 

phone. 

In this mode, if a fax arrives, the fax machine does not ring but directly receives the 

fax. If a call arrives, the fax machine rings to notify users of the call. 

− FAX ONLY: applicable to the situation that the fax machine is used only as a fax 

machine. 

In this mode, the fax machine switch calls into faxes and automatically receives all 

faxes. 

− MANUAL: applicable to the situation that the fax machine is frequently used as a 

phone. 

In this mode, the fax machine rings for every call. To send or receive faxes, you must 

enable the fax function manually after receiving a call. 

 Memory clearing 

Clear the memory periodically or print the memory data. If the recipient fax machine 

does not print the received data immediately, the data is stored in the memory. When the 

memory is used up, the fax machine can no longer receive faxes. 

 Ink box selection 

To ensure the print definition, use a high-quality ink box. 

5.2 Call Forwarding Faults 

This topic describes how to troubleshoot call forwarding faults. 

Symptom 

Common call forwarding service faults are as follows: 

 A call initiated by a intra-office user cannot be forwarded to another intra-office user. 

 A call initiated by a intra-office user cannot be forwarded to a external user. 

Possible Causes 

If a call made by A to B fails to be forwarded to C, the possible causes are as follows: 

 A does not have the right to call C. 

 The forwarding number of B are incorrect. 

 The call forwarding service of B conflicts with any other service. 

 The number used by A does not meet the peer device requirements. 
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Procedure 

Step 1 Access the command tree configuration page, and enter the Config mode. For details, see 

depg/depg/softco_depg_00149.xml. 

For details about how to use the LMT to run commands, see 

depg/depg/softco_depg_00170.xml. 

Step 2 Run the show subscriber by dn <string> command to check whether A has the right to call 

C. 

[%SoftCo95005500(config)]#show subscriber dn 5001  

  

Subscriber  

  

Dn   LongDn DomainName TermName UserType UserPriorLevel State      Source UserState   

---- ------ ---------- -------- -------- -------------- ---------- ------ ---------   

5001        5001       5001     NORMAL   Default         FAULT     0      NORMAL      

SubPBXNo FaxMode RegGroupId BindUserNum RemarkInfo DirectDialTKC RingTypeIndex   

-------- ------- ---------- ----------- ---------- ------------- -------------   

0        BYPASS  0          NA                     -             -               

CentrexGroup PickupGroup PbxGroup OutgoingRight IncomingRight       Telephonist   

------------ ----------- -------- ------------- ------------------- -----------   

-            -           -        INTER/LOCAL   INTER/LOCAL/DDD/IDD Yes           

AreaNumber IfUseCRBT   

---------- ---------   

           NO          

  

UserName faxmailnumber SubState NewMsgs OldMsgs voipdomain    BillingType SuspendedFlag   

-------- ------------- -------- ------- ------- ------------- ----------- -------------   

         -             Invalid  0       0       DefaultDomain Periodic    No              

PotswmiType                                    

-----------   

--   

 If no, run the config modify subscriber by dn <string> operateout add 

outgoingrights <inter|local|ddd|idd> command to add the right. 

 If yes, go to the next step. The user number 5001 has intra-office call right and local call 

right, as shown in above. 

Step 3 If C is a peer device user, run the show subscriber by dn  <string> type newservice 

command to check whether the forwarded-to number for B has been added. 

[%SoftCo95005500(config)]#show subscriber dn 5001 type newservice                   

  

New Service  

  

Rights              Register Information                

------------------- -------- ------------------------   

NORMAL              Y                                   

CALL_WAITING                                            

WAKEUP_CALL                                             

OPERATOR DISCONNECT Y                                   

OPERATOR INSERT     Y                                   

ABBREVIATIVEDIAL                                        

CLIP                Y                                   

CALLLIMIT                                               
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DDS                                                     

ABSENT_USER                                             

CFU                 Y         [Forward:813788888888#]  

CFB                                                     

CFNR                                                    

CFO                                                     

HOOKING_TRANSFER    Y                                   

AMEND_PASSWD        Y         [CalloutPassword:1234]    

CALLPARK                                                

  

------- Matched record number : [17] ------- 

 If no, run the config activeservice dn <string> type cfu value <string> command to 

add the forwarded-to number. 

 If yes, go to the next step. 

Step 4 Run the show subscriber by dn <string> type all command to check whether the call 

forwarding service of B conflicts with any other service (see Service Conflict List). 

 If yes, modify the configuration as required to avoid the conflicts. 

 If no, go to the next step. 

Step 5 Check whether the number of A meets the peer device requirements. 

For example,the number of A needs to configure long number when the SoftCo connect to the 

PSTN. 

 If no, see Setting Number Conversion Mode to modify the number change rule. 

 If yes, go to the next step. 

Step 6 See Step 4 in 3.10 Number Is Displayed Abnormally to check whether the number change 

rule is correct. 

Step 7 Run the show sip convert23tosharp switch  command to check whether the SIP character 

conversion function is enabled. Value 1 indicates yes and 0 indicates no. 

 If the command result is 1, run the config sip convert23tosharp flag off to disable the 

function. 

 If the command result is 0, go to the next step. 

Step 8 If the fault still persists, collect the fault information and send it to Huawei technical support 

engineers. For the contact information, see 1.6 Technical Support. 

Step 9 If you have performed the preceding steps, make a call to check whether the fault is rectified. 

If the call made by A to B can be forwarded to C successfully, the fault is rectified. 

----End 

5.3 Transfer Service Faults 

This topic describes how to troubleshoot call transfer service faults. 

Symptom 

Common call transfer service faults are as follows: 
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 Integrated access device (IAD) users fail to press the hookflash key. 

 Two-stage dialing fails after users press the hookflash key. 

Possible Causes 

If B fails to transfer an ongoing call with A to C by pressing the hookflash key, the possible 

causes are as follows: 

 Two-stage dialing signals fail to be detected due to poor network transmission 

performance. 

 B does not have the right to call C. 

 The hookflash function is disabled for B. 

 B uses an incorrect call transfer method. 

 The hookflash duration on B's phone differs from that on the SoftCo or the hookflash 

key is unavailable. 

 The IAD does not support the hookflash function. 

 The digit collection mode set on the SoftCo is different from that set on the IAD. 

Procedure 

Step 1 Check whether the network connection is normal. See 2.5 Network Information Analysis. 

Step 2 Run the show subscriber dn <string> command to check whether user B has the right to call 

user C. The user number 5001 has intra-office call right and local call right, as shown in 

Figure 5-1. 

If no, run the config modify subscriber dn <string> operateout add outgoingrights 

<inter|local|ddd|idd> command to assign B the outgoing call right. 

Figure 5-1 Outgoing call right 

 

 

Step 3 See related IP phone documents to whether the operation and configuration of IP phone is 

correct. 

1. Check whether the transfer service operation performed on the SIP phone is correct. 

2. Check whether the phone supports the hookflash function. 

3. Check whether the SIP phone configuration is correct. 
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 Check whether the digit collection mode is correct. See Figure 5-2. 

Figure 5-2 Digit collection mode 

 

 

 Check whether the voice codec mode match the SoftCo. as shown in Figure 5-3. 

Figure 5-3 Voice codec mode 

 

 

 If the RFC2833 digit collection mode is used, check whether the DTMF payload type 

match the peer device, as shown in Figure 5-4. 

Figure 5-4 DTMF payload type 

 

 

Step 4 If B uses a POTS phone, check whether the hookflash duration on the POTS phone is 

different from that on the SoftCo and check whether the hookflash key is available. 

If the hookflash key is unavailable, replace the phone. If the hookflash key functions properly, 

change the hookflash threshold on the SoftCo by running the corresponding command. 

 If the POTS phone is connected to the SoftCo5816 chassis, run the config 

hookflashtime mpu lowerlimit <30-1000> upperlimit <30-1000> command. 

 If the POTS phone is connected to the SoftCo5816 user box, run the config 

hookflashtime subbox no <1-4>lowerlimit<30-1000>upperlimit<30-1000> 

command. 

 If the POTS phone is connected to the SoftCo9500 user box, run the config 

hookflashtime subbox slot <2-9> port <1-4> lowerlimit <30-1000> upperlimit 

<30-1000> command. 

Step 5 If B is connected to the IAD, run display version command to check whether the IAD 

supports the hookflash function. 

If no, see IAD-related document to upgrade. 

 For IAD101H, IAD102H, IAD104H, support the hookflash before TS0402 

V300R001C01. 

 For IAD132E(T), support the hookflash before TS3202 V300R001C01. 

Step 6 If the SoftCo uses the SIP trunk to connect to the peer device, check whether the SoftCo and 

the peer device use the same digit collection mode. 
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Contact the peer engineer to check the digit collection mode and the value of PayloadTpye. If 

the RFC2833 digit collection mode is enabled on the peer device, perform the following 

operations on the SoftCo: 

1. Run the show cdsp argu command to view the digit collection mode. The RFC2833 

digit collection mode is disabled by default. This means that RFC2833Flag:0 is 

displayed. 

2. Run the config cdsp rfc2833switch <on|off> command in Config mode to enable the 

RFC2833 digit collection mode. 

3. Run the show cdsp payloadtype command to check whether the RFC2198 load (the 

value of PayloadTpye) is the same as that of the peer device. 

If the values are different, run the config cdsp payloadtype rfc2833 value<0-255> 

command in Config mode to change the value. 

Step 7 See 2.3 Log Analysis to capture the log and rectify the fault. 

Step 8 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.4 ONLY Service Faults 

This topic describes the common One Number Link You (ONLY) service fault and how to 

troubleshoot the One Number Link You (ONLY) service faults. 

5.4.1 ONLY Number cannot be bound 

This topic describes how to troubleshoot the One Number Link You (ONLY) service faults. 

Symptom 

Numbers cannot be bound by using the ONLY service. 

Possible Causes 

The possible causes are as follows: 

 The ONLY service is disabled for the user. 

 The number to be bound has the ONLY service. 

 The number to be bound (intra-office user) does not exist. 

 The ONLY service is enabled for the number to be bound (intra-office user) or the 

number has been bound to another ONLY number. 

Procedure 

Step 1 Run the show subscriber dn <string> type newservice command to check whether the 

primary terminal or the number to be bound has ONLY service, as shown in Figure 5-5. 

If the primary terminal has no ONLY service, run the config modify subscriber dn 

<string>operatenewservice add newservicerights unicall command to enable the service 

for the user. 

If the number to be bound has ONLY service, change to other number. 
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Figure 5-5 ONLY service 

 

 

Step 2 Run show subscriber command to check whether the number to be bound exists. 

Step 3 Run show subscriber command to check whether the ONLY service is enabled for the 

number to be bound (value of BindUserNum). 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.4.2 The User Hears the Busy Tone When Dials the ONLY 
Number 

This topic describes how to troubleshoot the uses hears the busy tone when dials the ONLY 

number. 

Symptom 

If a user dials the ONLY number when a bound user is busy, the user hears the busy tone. 

Possible Causes 

If a user (A) dials the ONLY number when a bound user (B) is busy, user A hears the busy 

tone. The possible causes are as follows: 

 The BusySelectMode field is set to active for the ONLY service. 

 The main terminal of the ONLY service is not a SIP terminal. 
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Procedure 

Step 1 Run the show subscriber unicall dn<string> command to check whether the value of 

BusySelectMode is active. 

If yes, run the config modify subscriber unicall dn <string> busyselectmode all command 

to change the value of BusySelectMode. 

Step 2 Check whether the main terminal is the SIP terminal. 

If no, use a SIP terminal. 

Step 3 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.4.3 The Sequential Ringing Service or the Simultaneous 
Ringing Service Fails through ONLY Service 

This topic describes how to troubleshoot the sequential ringing service or the simultaneous 

ringing service fails. 

Symptom 

The PSTN user cannot use the sequential ringing service or the simultaneous ringing service 

through ONLY service. 

Possible Causes 

The possible causes are as follows: 

 The outgoing prefix is not added to the PSTN user number to be bound. 

 The interval for sequential ringing is too long. 

 A validity period is set for the binding. 

 Services conflict. 

Procedure 

Step 1 Run the show subscriber unicall dn <string> command to check whether related attributes 

are correct, as shown in Figure 5-6. 

 Check whether the outgoing prefix (Info) is added to the bound PSTN user number. The 

extra-prefix 8 is added, as shown in Figure 5-6. 

If no, run the config modify subscriber unicall dn <string> bind pstnnum value 

<string> command to change the Info value. 

 Check whether a validity period (UseTime) is set for the binding. 

If yes, run the show timerange command to view the validity period. You can use the 

config modify timerange index <0-3840> begintime <string> endtime <string> 

command to modify the validity period.  

 Check whether the interval (SelectInte) for sequential ringing is long. 

Check whether the product of the value of selectinterval and the number of terminals is 

greater than 60 (seconds). If yes, run the config modify subscriber unicall dn 

<string>selectinterval <5-30> command to change the value of selectinterval. 
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Figure 5-6 ONLY information 

 

 

Step 2 Check whether the services enabled for the bound users conflict with the ONLY service. For 

details about related services, see 5.1.2 ONLY Service. 

Step 3 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.5 Main Number Service Fault 

This topic describes the common main number service and how to troubleshoot the main 

number service fault. 

5.5.1 Prompt Message Faults By Main Number Service 

This topic describes how to troubleshoot prompt message faults by main number service. 

Symptom 

Common main number service faults are as follows: 

 No prompt message is played when the main number is dialed. 

 An incorrect prompt message is played when the main number is dialed. 

Possible Causes 

The possible causes are as follows: 

 The access code for the VU main number is incorrect. 

 The MRU or MRS on the SoftCo9500 is not functioning properly. 

 The VU script is imported incorrectly or the VU script is incorrect. 

 The VU main number service is incorrectly configured. 

 Files in the voice.zip package are incorrect. 

 The default incoming number is set. 
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Procedure 

Step 1 Run the show prefix dn <string> command to check whether the access code for the VU 

main number is correct. The value of If4PSTN should be yes. 

If no, run the config modify prefix dn <string> if4pstnprefix yes command to change the 

access code. 

Step 2 Run the show board command on the SoftCo9500 to check whether the MRU or MRS is in 

OK state. 

If the status of the MRU or MRS is FAULT, proceed as follows to rectify the fault: 

1. Remove and then reinstall the MRU or MRS, or replace the MRU or MRS. 

2. Log in to the DTU and MRU through the serial port and run the show version command 

to check whether the versions of the DTU and MRU are the same as the version of the 

MCU. For details on how to log in to the MRU or MRS through the serial port, see How 

to Connect to the SoftCo Through the Serial Port or by Telnet.  

If the version of the MRU or MRS is different from the version of the MCU, upgrade the 

version.  

Step 3 Check whether the VU script is imported correctly. 

In the super user view mode of the SoftCo, run the debug print cli history info place 

<current|backup> command to check whether the VU script is imported. You can also 

rectify the fault by importing the VU script again. 

Step 4 Run the show prefix callcategory vu command to check whether the value of Vug is the 

same as the value of define OperationNO in the VU script, as shown in Figure 5-7 and 

Figure 5-8. 

By default, the value of Vug is 1 for the automatic main number service, and the value of Vug 

is 2 for the conference service. You can set the Vug value for any other service to a number 

ranging from 4 to 59. For example, the value 8 refers to the password-based call restriction 

service.  

Figure 5-7 Vug value 
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Figure 5-8 VU script 

 

 

Step 5 Check whether the channel for playing prompt messages in the script is correct, as shown in 

Figure 5-8. 

The value 250 indicates the ID of the channel for playing prompt messages. Use the tool for 

playing prompt messages to check whether the 250.pcm file is correct. If the file is incorrect, 

record the prompt messages again to generate a new 250.pcm. 

Step 6 Run the show protocol <at0|cassignal|isup|tup|pra|sip|h323> command to check whether 

the default incoming number is set. The default incoming number is set to be 88888888, as 

shown in Figure 5-9. 

If yes, run the config protocol <at0|cassignal|isup|tup|pra|sip|h323> officeno 

<0-254>defaultcldnum1 0000 command to delete the default incoming number. 

Figure 5-9 Default incoming number 

 

 

Step 7 See 2.3 Log Analysis to capture the log and rectify the fault. 

Step 8 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.5.2 User Faults By Main Number Service 

This topic describes how to troubleshoot user faults by main number service. 
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Symptom 

A calling party dials a number as prompted, but the call cannot be connected or is connected 

10 seconds later. 

Possible Causes 

The possible causes are as follows: 

 The VU script is imported incorrectly or the VU script is incorrect. 

 The digit collection mode on the SoftCo is different from that on the peer device. 

Procedure 

Step 1 Check whether the VU script is imported correctly. 

In the super user view mode of the SoftCo, run the debug print cli history info place 

<current|backup> command to check whether the VU script is imported. You can also 

rectify the fault by importing the VU script again. 

Step 2 Check whether the script is correct, as shown in Figure 5-10. 

 Check whether the value of groupNo is correct. 

 Check whether the value of transferNum is correct. 

 Check whether the maximum number of digits to be collected  (the fifth parameter of 

the PlayCollect) and the number end symbol (the ninth parameter of the PlayCollect) is 

correct. 

− Generally, the value is greater than or equal to the length of the called number. By 

default, the value is 32. 

− The default number end symbol is #. You are not advised to set the number end 

symbol to digits 0 to 9.  

For example, if you set the number end symbol to 0 and dials 3000, the SoftCo stops 

collecting digits when receiving a 0. This leads to call failure. 

Figure 5-10 VU script 

 

 

Step 3 If the SoftCo uses the SIP trunk to connect to the peer device, check whether the SoftCo and 

the peer device use the same digit collection mode. 

Contact the peer engineer to check the digit collection mode and the value of PayloadTpye. If 

the RFC2833 digit collection mode is enabled on the peer device, perform the following 

operations on the SoftCo: 
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1. Run the show cdsp argu command to view the digit collection mode. The RFC2833 

digit collection mode is disabled by default. This means that RFC2833Flag:0 is 

displayed. 

2. Run the config cdsp rfc2833switch <on|off> command in Config mode to enable the 

RFC2833 digit collection mode. 

3. Run the show cdsp payloadtype command to check whether the RFC2198 load (the 

value of PayloadTpye) is the same as that of the peer device. 

If the values are different, run the config cdsp payloadtype rfc2833 value<0-255> 

command in Config mode to change the value. 

Step 4 See 2.3 Log Analysis to capture the log and rectify the fault. 

Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.6 Fax service fault 

This topic describes the common main number service and how to troubleshoot the fax 

service fault. 

5.6.1 Faults Occurring When Sending or Receiving Faxes 

This topic describes how to troubleshoot faults occurring when sending or receiving faxes. 

Symptom 

The faults are as follows: 

 No fax can be sent. 

 No fax can be received. 

 Faxes can be sent successfully only on some fax machines. 

 Faxes can sometimes be sent successfully. 

 The clock source has not been configured or the clock source quality is low. 

Possible Causes 

The possible causes are as follows: 

 The network quality does not meet the requirement. 

 Operations on the fax machine are incorrect or the fax machine is faulty. 

 The fax machine is incorrectly set. 

 Fax modes of the SoftCo and IAD are different. 

 The receiving gain and sending gain are incorrectly set. 

 Some fax machines are incompatible with gateway devices. 

Procedure 

Step 1 Verify that the network quality meets the requirement. For details, see 2.5 Network 

Information Analysis. 
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Step 2 Verify that operations on the fax machine are correct. 

1. Before sending a fax, verify that papers are properly placed to the paper tray, and the fax 

machine is ready. 

2. When sending a fax, press the start button only after hearing the fax confirm tone sent by 

the other party. 

3. Check whether the memory of the fax machine is used up. If the memory is used up, 

clear the memory. 

4. Check whether papers are placed to paper trays of both sender and recipient fax 

machines. If there are papers on both fax machines, remove the papers from the recipient 

fax machine. 

Step 3 Verify that the fax machines are correctly set. 

1. If no fax can be sent, check whether the pulse dialing mode has been enabled. If this 

mode has been enabled, change it to the touch-tone dialing mode. 

2. If no fax can be received, check whether the function of rejecting faxes has been enabled. 

If this function has been enabled, disable it. 

Step 4 Check whether the transparent transmission mode has been enabled for the SoftCo, IAD. 

 For POTS or SIP users, run the show subscriber dn<string>command on the SoftCo to 

check whether the value of FaxMode is set to BYPASS. If the value is not BYPASS, run 

the config modify subscriber dn<string>faxmode <null|bypass|t38> command to 

change the value. 

 For H.248 users, run the show mg command on the SoftCo to check whether FaxMode 

is BYPASS. If the value is not BYPASS, run the config modify mg 

domainname<string>faxmode <null|bypass|t38> command to change the value. 

 On the IAD, run the display sip send-capability command to check whether pri is 0 and 

whether Mode is Transfer. If pri is not 0 and Mode is not Transfer, run the sip 

send-capability fax pri 0 transfer <G711a|G711u> command to change the values. 

Step 5 Adjust the sending and receiving gains to ensure that faxes can be sent and received 

successfully. 

On the IAD, run the pstnport attribute set<string><0-17> command to adjust the gains. 

Step 6 Use the comparison test to locate faults. 

1. Change a fax machine, and then verify that faxes can be sent and received successfully. 

2. Change a phone line of IAD, and then verify that faxes can be sent and received 

successfully. 

3. Change a trunk line, and then check whether faxes can be sent and received successfully. 

If the faxes can be sent and received successfully, contact the carrier to locate line faults. 

4. If faxes failed to be sent or received when a 32-port IAD is used, replace it with a 4-port 

IAD and check whether faxes can be sent and received successfully. 

A 4-port IAD amplifies signals by default to improve the success rate of sending and 

receiving faxes. 

Step 7 Use a packet catcher to capture signaling and RTP packets, and then rectify faults. For details 

on how to use the packet catcher, see How to Use the Wireshark. 

1. Check whether a re-invite message exists in the signaling process. If the message does 

not exist, use the Capsens to convert the captured RTP packets to a voice file, and then 

analyze the file. If the voice file is empty, analyze the log of the device that sent the 
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re-invite message to locate the fault. For details on how to use the Capsens, see 8.1 How 

to use the Capsens. 

2. Check whether the codec type and packaging duration contained in the re-invite message 

are the same as those contained in the 200 OK message. 

If they are different, change the codec type and packaging duration for the SoftCo fax 

service. Run the show system information command to view the voice codec type, as 

shown in Figure 5-11. 

− To set the voice codec type, run the config system codetype 

<g711a&g711u&g729&g723> command. 

− To change the priority of the voice codec type, run the config modify office 

no<0-254>codetype <g711a&g711u&g729&g723> command. 

− To change the packaging duration, run the config system voip 

<g711a&g711u&g729&g723> ptime <ten|twenty|thirty> command. 

Figure 5-11 Voice codec type on the SoftCo 

 

 

3. Check whether the value of Ptime in the RTP package that was sent is the same as that 

in the RTP package that was received. If they are different, contact Huawei technical 

support. 

Step 8 Use the CoolEdit to analyze the fax signals and rectify faults. For details on how to use the 

CoolEdit, see 8.2 How to use the CoolEdit. 

 Figure 5-12 compares waves for signals received and sent when an IAD user can send 

and receive faxes successfully. The average Root Mean Square (RMS) power is about 

-21 dB, as shown in Figure 5-13. 
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Figure 5-12 Waves for fax signals in normal cases 

 

 

Figure 5-13 RMS power in normal cases 

 

 

 Figure 5-14 compares waves for signals received and sent when an IAD user cannot send 

faxes. 

In the chart, 192.168.100.11_50000-168.168.0.140_6578_G711a is the waves for signals 

that are sent, and 168.168.0.140_6578-192.168.100.11_50000_G711a is the waves for 

signals that are received. 
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Figure 5-14 Waves for signals of faxes that cannot be sent 

 

 

 Figure 5-15 compares waves for signals received and sent when faxes are delayed. 

This fault is caused by incorrect trunk line connection. If this fault occurs, contact the 

peer device engineers to check the line. 

Figure 5-15 Waves for signals of delayed faxes 

 

 

Step 9 If the Time Division Multiplexing (TDM) trunk is used, see 4.2 E1 Trunk Exception to check 

whether the clock source has been configured. 

Step 10 If the fault persists, see 1.6 Technical Support to obtain technical support. 
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----End 

5.6.2 Fax Quality Is Low 

This topic describes how to troubleshoot the low fax quality. 

Symptom 

The symptoms are as follows: 

 Images and words are unclear. 

 The fax is sent successfully, but the peer party can only receive part of the pages. 

Possible Causes 

The possible causes are as follows: 

 The network quality does not meet the requirement. 

 The SoftCo is not grounded. 

 The clock source has not been configured or the clock source quality is low. 

Procedure 

Step 1 Check whether situations such as packet loss, delay, or jitter occur on the IP bearer network. 

For the detailed procedure, see 2.5 Network Information Analysis. 

Step 2 Check whether the SoftCo is grounded. 

Step 3 If the Time Division Multiplexing (TDM) trunk is used, see 4.2 E1 Trunk Exception to check 

whether the clock source has been configured. 

Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

5.7 Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

5.7.1 The System Asks the User to Press 0 to Forward the Call to 
the Reception Desk or Press 5 to Enter the VoIP Process When a 
User Dials the Main Number 

This topic describes how to troubleshoot the system asks the user to press 0 to forward the call 

to the reception desk or press 5 to enter the VoIP process. 

Symptom 

When the peer user dials the main number, the system asks the user to press 0 to forward the 

call to the reception desk or press 5 to enter the VoIP process. The peer user hears the voice 

prompt "Your call has been restricted.". 
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Possible Causes 

The VU script is configured correctly. Run the show trunkgroup no <0-6120> command. 

You can find that the value of BasicOutgoing is INTER. 

Procedure 
 Run the config modify trunkgroup no 31 outgoingright local command to add local 

call right. 

----End 

5.7.2 The Called Phone Rings Abnormally After the Calling Party 
Hangs up the Phone 

This topic describes how to troubleshoot the fault that the called phone rings abnormally after 

the calling party hangs up the phone. 

Symptom 

An IMS user or an intra-office user dials the switchboard number to call another intra-office 

user. The called intra-office user does not answer. After the called user hangs up the phone, 

the called user's phone rings. 

Possible Causes 

The IMS domain name set on the SIP trunk is different from that set in the IMS connection 

parameters. 

Procedure 

Step 1 Run the show peercomponent command to check the domain name set on the SIP trunk (the 

value of DomainName). 

Step 2 Run the show ims connectpara command to check the domain name set in the IMS 

connection parameters (the value of DomainName). 

Step 3 In Config mode, run the config modify peercomponent domainname<string>ip 

<A.B.C.D>tkcnum<1–1200> or config modify ims connectpara domainname<string>ip 

<A.B.C.D>officeselectcode<0–254>mode <master|slave> command to set domain names 

to the same. 

----End 

5.7.3 One or More User Phones Fail to Ring When the ONLY 
Service Is Used 

This topic describes how to troubleshoot an ONLY service fault. 

Symptom 

After a user dials the ONLY number, one or more user phones fail to ring if the sequential 

ringing service is enabled. 
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Possible Causes 

1. Run the show subscriber dn <string>type all command. If the value of 

PARALLEL_RING_SERVICE is Y, the sequential ringing service is enabled. 

2. Run the show ringservice dn <string> command to view the numbers used in the 

sequential ringing service and run the show subscriber unicall dn <string> command 

to view the numbers in the ONLY service. You can find that the same number is used in 

the two services. The bound user phones do not ring because the sequential ringing 

service conflicts with the ONLY service. 

Procedure 
 Run the config delete ringservice dn <string> command to disable the sequential 

ringing service. 

----End 

5.7.4 Call Transfer Service of a SoftCo User Is Abnormal When 
the SoftCo Is Connected to the IMS 

This topic describes how to troubleshoot a fault that occurs when the SoftCo is connected to 

the IMS. 

Symptom 

After a SoftCo user presses the hookflash to transfer a call to another SoftCo user, the two 

SoftCo users cannot hear each other. 

Possible Causes 

The SoftCo is connected to the IMS through the SBC and all services are provided by the IMS. 

The SBC does not support media stream, so the calling party and the called party cannot hear 

each other. 

Procedure 
 Upgrade the SoftCo version to V100R002C04. For details, see the SoftCo Upgrade 

Guide. 

----End 

5.7.5 No Prompt Message is Played When the Mobile User Rejects 
the Call 

This topic describes how to troubleshoot the One Number Link You (ONLY) service faults. 

Symptom 

When the called party is a mobile user and rejects a sequential ringing service connection, no 

prompt message is played. 
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Possible Causes 

A possible cause is that the mobile user is not the last user for the sequential ringing service. 

Procedure 
 Run the show subscriber unicall dn <string> command to check whether the value of 

Priority in Terminal bind information is 3. 

If no, run the config modify subscriber unicall dn <string>modbind pstnnum value 

<string> priority 3 command to change the mobile user to the last user. 

----End 

5.7.6 IMS User Cannot Be Called in the Simultaneous Ringing 
Service (ONLY) 

This topic describes how to troubleshoot a simultaneous ringing service fault. 

Symptom 

SoftCo ONLY number B is bound to IMS number C. When IMS user A dials ONLY number 

B, the phone of IMS number C does not ring. However, SoftCo ONLY number B can call 

IMS user C. In addition, when other intra-office call B, the phone of IMS number C rings. 

Possible Causes 

The multiple call function is enabled for the IMS account bound to the ONLY number. 

Procedure 
 Contact the peer office's engineer to enable the multiple call function for the IMS 

account on the IMS. 

----End 

5.7.7 Fault Occurs When an IMS User Is Connected in the 
Simultaneous Ringing Service (ONLY) 

This topic describes how to troubleshoot a fault that occurs when an IMS user is connected in 

the simultaneous ringing service. 

Symptom 

SoftCo ONLY number B is bound to IMS number C. When IMS user A dials ONLY number 

B, the phone of IMS number C rings. When picking up the phone, IMS user C hears the busy 

tone or the call restriction prompt message. 

Possible Causes 

If the session border controller (SBC) proxy is used, the calling party and called party cannot 

hear each other. 
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Procedure 
 Contact the peer office's engineer to enable the functions of multiple call, transfer upon 

inquiry, and call holding for the corresponding IMS account. 

----End 

5.7.8 IMS User Cannot Transfer Calls 

This topic describes how to troubleshoot a fault that occurs when an IMS user attempts to 

transfer calls. 

Symptom 

When an IMS user dials the VU number and then enters another IMS user number as 

prompted, call transfer fails. 

Possible Causes 
 The IMS registration group ID is not added to the VU prefix. 

 The user to whom the call is to be transferred does not exist or the user is busy. 

 The call transfer service is disabled on the IMS. 

Procedure 

Step 1 Run the show prefix dn <string> command to check whether the registration group ID 

(RegGroupId) is added to the VU prefix. 

If no, add the registration group ID to the VU prefix. 

Step 2 On the IMS, check whether the user to whom the call is to be transferred exists or whether the 

user is idle. 

Step 3 On the IMS, check  whether  the CFB service and call holding service is enable. 

If no, contact the IMS's engineer to enable the CFB service and call holding service for the 

registration group ID corresponding to the VU. 

Step 4 If the fault persists, contact Huawei customer service center or the local office. 

----End 

5.7.9 Fax Fails When the SoftCo Is Connected to the IMS 

This topic describes how to analyze and troubleshoot the fax fault when the SoftCo is 

connected to the IMS. 

Symptom 

Faxes can be sent or receive only. 

Possible Causes 

The media attribute does not match the SoftCo so that the fax is abnormal. 
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Procedure 

Step 1 Use the packet capture tool to capture the INVITE SDP message form the peer device, then 

discover the SDP message's media attribute is modem, as shown in Figure 5-16. 

Figure 5-16 SDP message 

 

 

Step 2 Run the show softagru command to view the software parameter ID of fax and modem sdp 

attr mode (the value of Tpye). 

[%SoftCo5816(config)]#show softargu   

  

All Arguments in SoftArgu Table  

  

Type Value     Meaning  

---- --------- -----------------------  

0    --        System max user number  

1    --        System max cpu ration  

...  

255  --        fax and modem sdp attr mode [0: FAX/MODEM, 1: X-FAX/X-MODEM] 

Step 3 Run the config softargu type 255 value 0 command to modify the media attribute to 

FAX/MODEM. 

----End 

5.7.10 Faxes Cannot Be Sent Using T.38 

This topic describes how to troubleshoot a fault that occurs when faxes are sent using T.38.  

Symptom 

The MRU and MRS are configured on the SoftCo. User A sends a fax to user B. The fax fails 

to be sent using T.38.  

Possible Causes 

The default values of conference parameter for the MRS and MRU are both yes. If both the 

MRS and MRU are configured on the SoftCo, the MRS is used when a user sends a fax. The 

MRS does not support T.38 and the fax fails to be sent. 
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Procedure 
 Run the config modify board slot <2-9> type mru conference no command to change 

the value of conference parameter for the MRU to no.  

----End 
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6 System Device Faults 

About This Chapter 

System device faults usually occur in the power supply system or during the upgrade. 

6.1  Faults Occurring During the Upgrade 

This topic describes how to troubleshoot a fault occurring during the upgrade. 

6.2  Power Supply Exception 

This topic describes how to troubleshoot power supply exceptions. 

6.3  Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

6.1 Faults Occurring During the Upgrade 

This topic describes how to troubleshoot a fault occurring during the upgrade. 

Symptom 

The following faults frequently occur during the upgrade: 

 Data cannot be backed up. 

 The version software cannot be loaded. 

Possible Causes 

Junk data exists in the Flash memory or the Flash memory is insufficient. 

Procedure 

Step 1 Connect to the SoftCo through the serial port. See How to Connect to the SoftCo Through the 

Serial Port or by Telnet. 

Step 2 Start the BOOT1 mode and run the KDF command to delete all the data from the Flash 

memory, as shown in Figure 6-1. 
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Figure 6-1 Deleting data 

 

 

Step 3 Run the boot command to restart the SoftCo. 

Step 4 Upgrade the SoftCo again. For details, see the SoftCo Upgrade Guide. 

----End 

6.2 Power Supply Exception 

This topic describes how to troubleshoot power supply exceptions. 

Symptom 

The SoftCo9500 is powered on. After you press the Mute button, the buzzer keeps ringing. 

Possible Causes 

The possible causes are as follows: 

 The power supply is abnormal. 

 The power module is incorrectly connected to the power cable. 

 The external power supply is abnormal. 

 The power module or the filler panel is faulty. 

Procedure 

Step 1 Check whether the RUN indicator is normal. Take measures according to the indicator status, 

which is described in 2.2 Alarm Analysis. 

 
If the power indicator blinks abnormally, check whether the voltage is low. 

Step 2 Check whether the power module and power cable are fastened. Remove and reconnect the 

power cable and power on the device to check whether the alarm is cleared. 

 If yes, check whether alarms are still displayed. 

− If no alarms are generated but the power supply remains abnormal, the line voltage 

may be instable or the short-term self-protection function is enabled. 

− If an alarm is generated, output over-voltage has occurred. 

 If no, replace the power module. 

If the alarm still exists, the external power supply may be faulty or the power supply 

alarm is reported mistakenly. 
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Step 3 Check whether power modules and filler panels in other slots are fastened and whether all idle 

power modules are powered on. If no, fasten power modules and filler panels and power on 

idle power modules. 

Step 4 Fasten and power on the power modules. Then check whether an alarm is generated. If so, 

replace the power modules or filler panels. 

Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support. 

----End 

6.3 Typical Cases 

This topic describes the fault symptom, cause analysis, and fault troubleshooting. 

6.3.1 Voice Service Fails Frequently After the SoftCo Is Upgraded 

This topic describes how to troubleshoot a fault that occurs after the SoftCo is upgraded. 

Symptom 

After the SoftCo is upgraded, users frequently report failures such as call drop, registration 

failure, and low voice quality. 

Possible Causes 

The network is congested due to inconsistent working modes of the SoftCo's service network 

ports and the switch. 

Procedure 

Step 1 View the alarm information through the OMU. You may find that alarms such as SIP 

terminal failure are reported continuously even at night when there is no or low traffic. In 

addition, the phone sets do not receive a response to the re-registration request and network 

packets are lost. 

Step 2 View the status of the Ethernet switch that connects to the SoftCo. You can find that the 

Ethernet switch works in half-duplex mode at 100 Mbit/s, whereas the SoftCo works in 

full-duplex mode at 100 Mbit/s. The packet loss rate is high due to the different working 

modes of the SoftCo and the Ethernet switch. 

Step 3 Change the working mode of the Ethernet switch because the network adapter of the SoftCo 

does not support automatic negotiation. For example, run the following command to change 

the working mode of the switch in a specific office: 

lsw  set portno 17 status enable auto on speed speed100 duplex full flowctrl disable 

 
 The MCU has two network ports. The preceding fault occurs only on network port 0. It is 

recommended that you use network port 1. If network port 0 must be used, perform step 3 to rectify 

the fault. 

 To configure the command to change the working mode of a switch, refer to the documents that are 

delivered with the actual switch model. 

----End 
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6.3.2 Uploading or Downloading a File Fails 

This topic describes how to troubleshoot a fault that occurs when a user uploads or downloads 

a file. 

Symptom 

The system displays an error message when a user uploads a file to the TFTP server or 

downloads a file (for example, a license file) from the TFTP server. 

Possible Causes 
 The license.dat file on the TFTP server is named incorrectly. 

 The value of hostip on the SoftCo is different from the IP address of the TFTP server. 

 If downloading a file fails, the file's directory on the TFTP server may be incorrect or the 

file to be downloaded may be unavailable. 

Procedure 

Step 1 Check whether the license.dat file on the TFTP server is named correctly. The correct file 

name is license.dat. 

Step 2 Start the Config mode of the SoftCo and run the config system hostip <A.B.C.D> command 

to set a correct IP address for the TFTP server. 

Step 3 Check whether the loading directory on the TFTP server is correct. 

----End 

6.3.3 Pinging Another Device from the SoftCo Fails 

This topic describes how to troubleshoot a fault that occurs when another device is pinged 

from the SoftCo. 

Symptom 

Another device cannot be pinged from the SoftCo. Assume that the device is A. 

Possible Causes 
 The network cable is disconnected or faulty. 

 The IP address or subnet mask of the SoftCo is incorrect. 

 After the IP address of the SoftCo is changed, the system is not restarted. As a result, the 

changed IP address does not take effect. 

Procedure 

Step 1 Verify that device A and the switch are connected and the network cable is normal. 

Step 2 Verify that the SoftCo and the switch are connected and the network cable is normal. 

Step 3 Run the show system information command to check the network configuration of the 

SoftCo. 
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 If the IP address of the SoftCo and that of device A are on different network segments, 

change the IP address of the SoftCo to the same network segment as device A. 

 If the IP address of the SoftCo and that of device A are on the same network segment, the 

IP address of the SoftCo does not take effect after the IP address is changed. In this case, 

restart the system to make the IP address take effect. 

----End 
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7 Terminal and gateway faults 

About This Chapter 

Terminal and gateway device include IAD and IP Phone. 

7.1  IP Phone 

This topic describes the common methods for locating and rectifying IP Phone faults. 

7.2  IAD 

This topic describes the common methods for locating and rectifying IAD faults. 

7.1 IP Phone 

This topic describes the common methods for locating and rectifying IP Phone faults. 

7.1.1 IP Phone Cannot Be Started 

This topic describes how to troubleshoot a starting fault of IP Phone. 

Symptom 

An IP phone cannot be started and nothing is displayed on the screen. 

Possible Causes 

The software of the IP phone is faulty. 

Procedure 
 To recover the software on the ET525, do as follows: 

1. Connect the PC and IP phone to the same hub. Check and ensure that only one network 

adapter is installed on the PC. If more than one network adapter is installed, enable one 

network adapter and disable the others. 

2. Set the IP address of the PC to 168.75.215.188, the subnet mask to 255.255.0.0, and the 

IP address of the gateway to 168.75.215.188. 
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3. Start the Trivial File Transfer Protocol (TFTP) server on the PC, set the load directory, 

and start the TFTP service. Then place the upgrade software to the load directory. 

4. Press *+# on the IP phone, cut off the power supply, and restore the power to start the IP 

phone. The IP phone will download software from the TFTP server. 

----End 

7.1.2 IP Phone Is Disconnected from the Network 

This topic describes how to troubleshoot disconnect fault of IP Phone. 

Symptom 

The network status indicator light or screen display is not normal, for example, the T-shaped 

icon in the upper-left corner of the screen is blinking, or the screen displays messages such as 

"Check Network Connection", "Network Starting", or "Configuration". 

Possible Causes 
 The LAN interface is disconnected from the switch. 

 Network parameters such as IP addresses are set incorrectly. 

Procedure 

Step 1 Check and ensure that the LAN interface is connected to the switch. 

Step 2 Check and ensure that fields such as IP addresses are set correctly. For detailed operation, see 

the related IP Phone document. 

----End 

7.1.3 Web Pages Cannot Be Configured 

This topic describes how to troubleshoot configuring fault of IP Phone. 

Symptom 

After logging in to the Web page, you cannot configure pages including the SIP account page 

and the advanced parameters page. 

Possible Causes 

When you log in to the Web page as an ordinary user with the password 123, you can only 

view statuses and change network parameters. You, however, cannot set advanced parameters 

such as the SIP account. 

Procedure 
 Log out of the Web page, and then log in to the Web page again as an administrator with 

the password admin. 

----End 
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7.1.4 IP Phone Can Receive Incoming Calls but Cannot Make 
Outgoing Calls 

This topic describes how to troubleshoot none but receiving incoming calls fault of IP Phone. 

Symptom 

On the ET522 or ET322, you can receive incoming calls but cannot make outgoing calls. 

Possible Causes 

The fault occurs when the proxy server is not set on the ET522 or ET322. These two types of 

IP phones can work normally even if the registration server is not set. The proxy server, 

however, must be set so that they can work normally. 

Procedure 

Step 1 Log in to the Web page of the IP phone with an administrator account, and then access the 

SIP configuration page. 

Step 2 Set the SoftCo as the proxy server. For the ET522, enter the IP address of the SoftCo in the 

SIP Proxy Server text box. 

----End 

7.1.5 IP Phone Can Receive Outgoing Calls but Cannot Make 
Incoming Calls 

This topic describes how to troubleshoot none but making outgoing calls fault of IP Phone. 

Symptom 

You can make outgoing calls but cannot receive incoming calls on the ET523. 

Possible Causes 

When the do-not-disturb (DND) function is enabled on the ET523, the incoming calls are 

rejected. 

Procedure 
 Check the DND icon. If the icon blinks, you can infer that the DND function is enabled. 

When the ET523 is not used, press MUTE/DEL to disable the DND function. 

----End 

7.1.6 IP Phone Cannot Provide Two-Stage Dialing 

This topic describes how to troubleshoot the two-stage dialing fault of IP Phone. 
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Symptom 

An IP phone cannot provide the two-stage dialing. 

Possible Causes 

The SoftCo supports two dual-tone multifrequency (DTMF) signal collection modes (that is, 

in-audio and Info); therefore, the DTMF signal sending modes of the IP phone must be set to 

in-audio and Info modes. 

Procedure 
 Check DTMF signal sending modes of the IP phone and ensure that in-audio and Info 

modes are selected. For the ET523, access the SIP configuration page (that is, the 

ACCOUNT page), and then select in-audio and via SIP INFO in Send DTMF. 

 
When the IP phone supports G.711A codec, it is recommended that you set top priority for G.711A, that 

is, set choice 1 in the Preferred Vocoder area to G.711A. 

----End 

7.1.7 IP Phone Cannot Obtain Time from the NTP Server 

This topic describes how to troubleshoot obtaining time fault of IP Phone. 

Symptom 

When a PC is used as the NTP server, an IP phone cannot obtain time from the PC. 

Possible Causes 
 The fault occurs on the ET523 of V1.1.2.4. 

 The firewall is installed on the PC, so NTP packets sent by the IP phone are intercepted. 

Procedure 

Step 1 Check the version of the ET523 on the STATUS page. If the version is V1.1.2.4, upgrade it to 

a later version. 

Step 2 If the firewall is installed on the PC, rectify the fault in one of the following ways: 

 Disable the firewall on the PC. 

 On the firewall, configure rules so that NTP packets can pass. Add an exception with the 

port number 123 (a port number frequently used by the NTP server) and the protocol 

UDP. 

----End 

7.2 IAD 

This topic describes the common methods for locating and rectifying IAD faults. 
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7.2.1 The System Time Restores to the Factory Setting After the 
IAD Is Restarted 

This topic describes how to troubleshoot the factory setting fault of IP Phone. 

Symptom 

After the IAD is restarted, the time displayed on the phone set connected to the IAD changes 

to the factory setting time of the IAD. 

Possible Causes 

The IAD does not use the SNTP function to synchronize the time with the SoftCo. 

Procedure 

Step 1 Start the SNTP service of the SoftCo. 

[%SoftCo9500(config)]#start sntpserver 

Step 2 Start the SNTP client on the IAD to keep time synchronization with the SoftCo. 

TERMINAL(config)#sntp server address 192.168.10.10 //Sets the IP address of the SNTP 

server. In this example, the SoftCo is used as the SNTP server. The IP address is 

192.168.10.10.  

TERMINAL(config)#sntp time-zone + 8 //Sets the time zone to UTC+8. You need to change 

the value according to the actual situation.  

TERMINAL(config)#sntp interval 60 //Sets the time interval for synchronization. In this 

example, the value is 60s. 

Step 3 If many IADs are used, and you have the UCEMS tool, you can enable the SNTP function of 

the IADs in batches on the UCEMS. 

Right-click the IAD to be configured in a specific area and select Advanced Parameters > 

Device Time Configuration from the shortcut menu. In the dialog box that is displayed, 

select Synchronize Time, as shown in Figure 7-1. 

Figure 7-1 Enabling the SNTP function of the IADs in batches through the UCEMS 

 

 

----End 
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7.2.2 Call Is Abnormal If an IAD User Does Not Dial # 

This topic describes how to troubleshoot a fault that occurs when an IAD user does not dial 

the pound key (#). 

Symptom 

An IAD user does not dial the pound key (#) after dialing a user number, resulting in an 

excessively long connection time. 

Possible Causes 

The IAD does not support the function of reporting a number digit by digit. 

Procedure 

Step 1 Run the show version command check whether the SoftCo support the function of reporting a 

number digit by digit. Versions later than V100R002C02B089 support the function of 

reporting a number digit by digit. 

Step 2 Set a digitmap so that the user does not need to dial the pound key (#). 

1. Run the show softargu command on the SoftCo to view the value of Tpye 

corresponding to sip suppont iad no pond switch. 

[%SoftCo5816(config)]#show softargu   

  

All Arguments in SoftArgu Table  

  

Type Value      Meaning                                                               

---- ---------- 

-------------------------------------------------------------------   

0    --         System max user number                                                

1    --         System max cpu ration   

...  

282  --         sip support iad no pond switch[1:(open) 0:close default:0] 

Run the config softargu type 282 value 1 command to open the parameter. 

2. Depending on the SoftCo version, you can use either of the following methods to set a 

digitmap: 

 If the SoftCo version is V100R002C02B089 or later, run the config add digitmap 

protocol sip value <string> sendmapswitch on command on the SoftCo. 

Set sendmapswitch to on, indicating that the SoftCo automatically sends the digitmap to 

the IAD. 

 If the SoftCo version is earlier than V100R002C02B089, run the sip digitmap<string> 

command on the IAD. 

----End 

7.2.3 Dialing Error Message Is Played When an IAD User Dials an 
Extension Number 

This topic describes how to troubleshoot a fault that occurs when an IAD user dials an 

extension number. 
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Symptom 

An IAD user makes a call to the PSTN switchboard, and then dials an extension number when 

prompted. A voice message indicating that the dialed number is incorrect is played. 

Possible Causes 

The RFC2833 dialing mode is not enabled for the IAD and SoftCo. 

Procedure 

Step 1 Run the sip send-capability 2833 command on the IAD to enable the RFC2833 dialing 

mode. 

Step 2 Run the config cdsp rfc2833 switch on command on the SoftCo to enable the RFC2833 

dialing mode. 

----End 

7.2.4 IAD User Hears Beeps During a Call 

This topic describes how to troubleshoot a fault that occurs during a call. 

Symptom 

An IAD user hears beeps during a call. 

Possible Causes 

The RFC2833 digit collection mode is enabled for the IAD. 

Procedure 
 If the digit collection function is not affected, run the undo sip send-capability 2833 

command on the IAD to disable the RFC2833 digit collection mode. 

----End 

7.2.5 Low Volume for an IAD User 

This topic describes how to troubleshoot a fault that causes low voice volume. 

Symptom 

The voice volume for an IAD user is low. 

Possible Causes 

The phone volume is low. 

Procedure 

Step 1 Run the dsp send-gain<2,64> command to adjust the DSP transmit gain. 
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In the command, <2,64> indicates the gain ranges from -31 dB to 0 dB, 0.5 dB is to be added 

for each level. 

Step 2 Run the dsp recv-gain<2,64> command to adjust the DSP receive gain. 

In the command, <2,64> indicates the gain ranges from -31 dB to 0 dB, 0.5 dB is to be added 

for each level. 

----End 

7.2.6 Call Ends When the IAD user Is Picked Up in Hands-free 
Mode 

This topic describes how to troubleshoot a fault that occurs when an IAD user picks up the 

phone in hands-free mode. 

Symptom 

An IAD user picks up the phone after hearing that the peer user has picked up the phone in 

hands-free mode. When the IAD user hears the hookflash prompt tone, the call immediately 

ends. 

Possible Causes 

Due to the user's phone problem, the IAD mistakenly assumes that the call has ended and 

reports a hookflash event. 

Procedure 

Step 1 Run the devasi parameter set ? command to view the maximum and minimum hookflash 

durations for the IAD, as shown in Figure 7-2. 

Figure 7-2 Maximum and minimum hookflash durations 

 

 

Step 2 Run the devasi parameter set 3 80 command to increase the maximum hookflash duration. 

Step 3 Run the devasi parameter set 3 50 command to decrease the minimum hookflash duration. 

----End 
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7.2.7 Echoes Can Be Heard When an IAD User Calls a PSTN User 

This topic describes how to troubleshoot a fault that occurs when an IAD user calls a PSTN 

user. 

Symptom 

Echoes can be heard when an IAD user calls a PSTN user.  

Possible Causes 
 The echoes are acoustic feedback from the user's microphone. 

 The EC function is disabled or the mute detection function is enabled on the IAD. 

 The receive gain or transmit gain on the IAD is set incorrectly. 

 The EC parameter of the peer gateway is set incorrectly. 

Procedure 

Step 1 Check whether the echoes are acoustic feedback from the user's microphone. 

The PSTN user covers the microphone to check whether the echoes disappear. If yes, the 

echoes are acoustic. Acoustic echoes generally occur when the hands-free function is enabled. 

To prevent acoustic echoes, disable the hands-free function. 

Step 2 Check whether the EC is set correctly. 

Run the show system voip argu algo g711 command on the SoftCo. If the EC on the IAD is 

set incorrectly, modify the setting as required. 

 If the PSTN user hears echoes, run the dsp ec-enable on command on the IAD to enable 

the EC function and run the dsp vad-enable off command to disable the mute detection 

function. 

 If the IAD user hears echoes, run the show system voip argu algo g711 command on the 

SoftCo to check whether the value of EchoCancel is ON. If no, Run the config system 

voip algo g711 echocancel on command to enable the EC function on the SoftCo. 

Step 3 Run the pstnport attribute set command on the IAD to reduce the receive gain and transmit 

gain. 

 If the transmit gains of IAD108H and IAD132H are both 0 dB, adjust the gains to -3 dB. 

 If the receive gain of IAD108H is -3.5 dB, adjust the gain to -7 dB to -8.5 dB. 

 If the receive gain of IAD132E(T) is 0 dB, adjust the gain to -3.5 dB to -7 dB. 

 
Do not reduce the receive gain or transmit gain too much, or the voice may be intermittent or 

excessively low. The default gains are recommended. 

Step 4 If the fault persists after you adjust the port gains, on the IAD, run the dsp recv-gain 

command to adjust the DSP receive gain, and run the dsp send-gain command to adjust the 

DSP transmit gain. 

Step 5 Contact the peer office's engineers to check whether the EC parameter of the peer gateway is 

set correctly. 

If no, ask the peer office's engineers to deal with fault. 

----End 
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8 Common Tool 

About This Chapter 

You can make use of common tool to troubleshoot the fault. 

8.1  How to use the Capsens 

You can download Capsens tool from internet. 

8.2  How to use the CoolEdit 

You can download CoolEdit tool from internet. 

8.1 How to use the Capsens 

You can download Capsens tool from internet. 

Context 

Use Capsens to change RTP packet to wav file. 

 
The detail direction of Capsens tool for use see Capsens-related document. 

Procedure 

Step 1 Double-click , run Capsens. 

Step 2 Choose Tool > CAP2WAV, the Cap file convert to wav file is displayed. 

Step 3 Click , choose the relevant file which need to convert. 

Step 4 Click Convert to change .cap to .wav. 

----End 
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8.2 How to use the CoolEdit 

You can download CoolEdit tool from internet. 

Context 

The CoolEdit can be used to the frequency analysis of fax sending and receiving. 

 
The detail direction of CoolEdit tool for use see CoolEdit-related document. 

Procedure 

Step 1 Double-click , run CoolEdit. 

Step 2 In the main menu, choose File  > Open. The open dialog is displayed. Then choose .wav 

file. the waveform is displayed in the main interface, as shown in Figure 8-1. 

Figure 8-1 Wave spectrum 

 

 

Step 3 In the toolbar click , the frequency spectrum is displayed, as shown in Figure 8-2. 
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Figure 8-2 Frequency spectrum 

 

 

Step 4 In the toolbar click  to contrasting send and receive signal, as shown in Figure 8-3. 

Figure 8-3 Contrasted signal spectrum 

 

 

Step 5 In the main menu, choose Analyze > Statistics, the Waveform statistics is displayed, as 

shown in Figure 8-4. 
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Figure 8-4 Waveform statistics 
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	2. Check whether the cable is connected correctly or whether the connector is rusty.
	3. Check whether the cable is excessively long according to the cable specifications.
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	Step 3 Run the show board command on the SoftCo9500 or the show card command on the SoftCo5816 to check whether the DTU and MRU are in OK state.
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	1. When intra-office calls external user, check whether the SoftCo sends a SETUP message to the peer device, as shown in Figure 4-13.
	Figure 4-13 SETUP message

	2. When intra-office calls external user, check whether the calling/called number type and numbering plan in the SETUP message meet the requirements of the peer device. The Type of number indicates the number type and the Numbering plan identification indi=
	3. When external user calls intra-office, check whether the format of the SETUP message sent by the peer device is correct and whether the SETUP message carries the called number information. If no, contact the peer device engineers.
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	Figure 4-14 User registration group

	Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support.
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	Step 3 Use the show subpbx command to check whether the outgoing calling number (OutConfDn) and the registration group ID (RegGroupID) of the conference are set. The outgoing calling number and registration group ID are set, as shown in Figure 4-15.
	Figure 4-15 User registration group

	Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support.
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	Step 1 Check that the E1 trunk cable is normal and that the clock source is configured. For details, see 4.2 E1 Trunk Exception.
	Step 2 Check whether the intra-office and outgoing prefixes are configured and whether the board status is normal. For details, see step 2 and step 3 in 4.3 Call Fails on the PRA Trunk.
	Step 3 Check whether the trunk circuit is faulty.
	Step 4 Run the show mtplink command to check whether the trunk link status is OK (value of State).
	Step 5 See 2.4 Signaling Analysis to trace signaling process, check the call fail reason and deal with the fault.
	Step 6 If the fault persists, see 1.6 Technical Support to obtain technical support.
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	Step 8 If the fault persists, please obtain 1.6 Technical Support.
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	Procedure
	Step 1 Run the show prefix dn 9 command to check the outgoing prefix attributes. As shown in Figure 4-18, the calling number change attribute is not configured for the outgoing prefix and the value of UselongCLI is NO.
	Figure 4-18 Outgoing prefix attributes

	Step 2 Run the config add predeal index 5 changetype modify changepos 0 changelen 24 newdn 700 command to configure the number index.
	Step 3 Run the config modify prefix 9 clipredeal yes cliindex 5 uselongcli yes command to modify the outgoing prefix attributes so that the calling number meets PSTN requirements.
	Step 4 Run the show softargu command to check the Type field corresponding to PRA NumberPlan Identification. The software parameter ID corresponding to PRA NumberPlan Identification is 257.
	Step 5 Run the config softargu type 257 value 1 and config protocol pra officeno 0 typeofcldnumber unknown typeofclinumber national commands to modify the numbering scheme.


	4.8.3  Prompts for the Extension Number or a User Hears the Busy Tone When the User Makes a Call to the Main Number Through the AT0 Trunk
	Symptom
	Possible Causes
	Procedure

	4.8.4  Connecting a Call on the AT0 Trunk Takes a Long Time
	Symptom
	Possible Causes
	Procedure

	4.8.5  Calling Number Is Not Displayed for an AT0 Trunk Call
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the CLIP service is enabled for the SoftCo user. If the CLIP service is not enabled, ask the user to subscribe to the CLIP service.
	Step 2 Check whether FSK signals are used.
	Step 3 Increase the AT0 incoming gain (adgain). The default AT0 incoming gain is 6.
	Step 4 If the fault persists, contact Huawei customer service center or the local office.


	4.8.6  Called Party Cannot Hear the Busy Tone After the Calling Party Hangs Up on an AT0 Trunk Call
	Symptom
	Possible Causes
	Procedure
	Step 1 Connect the phone to the AT0 trunk interface provided by the carrier and call the SoftCo user using the PSTN number. Hang up after the call is connected. Then check whether the called party hears the busy tone. If no, contact peer office engine...
	Step 2 Increase the AT0 incoming gain (adgain). The default AT0 incoming gain is 6.
	Step 3 If the fault persists, contact Huawei customer service center or the local office.


	4.8.7  Call Fails When the Mobile User Calls the Intra-office Analog User on the AT0 Trunk
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the SoftCo is grounded.
	Step 2 Connect analog user cable of the carrier or the ATU board on the SoftCo to the grounding terminal, which used to clear the environment interruption.
	Figure 4-19 Grounding connection

	Step 3 If the fault persists, contact Huawei customer service center or Huawei local offices.


	4.8.8  Calls Made Through the AT0 Trunk Are Always Connected to the Same Number
	Symptom
	Possible Causes
	Procedure

	4.8.9  Fault Occurs When a Moderator Invites a User to Join a Conference Call Through the AT0 Trunk
	Symptom
	Possible Causes
	Procedure

	4.8.10  Simultaneous/Sequential Ringing Service Cannot Be Used When a User Number of the Peer Device Connected to the AT0 Trunk Is Used for the Service
	Symptom
	Possible Causes
	Procedure



	5  Service faults
	About This Chapter
	5.1  Background
	5.1.1  Call Forwarding/Transfer Service
	5.1.2  ONLY Service
	5.1.3  Fax

	5.2  Call Forwarding Faults
	Symptom
	Possible Causes
	Procedure
	Step 1 Access the command tree configuration page, and enter the Config mode. For details, see depg/depg/softco_depg_00149.xml.
	Step 2 Run the show subscriber by dn <string> command to check whether A has the right to call C.
	Step 3 If C is a peer device user, run the show subscriber by dn  <string> type newservice command to check whether the forwarded-to number for B has been added.
	Step 4 Run the show subscriber by dn <string> type all command to check whether the call forwarding service of B conflicts with any other service (see Service Conflict List).
	Step 5 Check whether the number of A meets the peer device requirements.
	Step 6 See Step 4 in 3.10 Number Is Displayed Abnormally to check whether the number change rule is correct.
	Step 7 Run the show sip convert23tosharp switch  command to check whether the SIP character conversion function is enabled. Value 1 indicates yes and 0 indicates no.
	Step 8 If the fault still persists, collect the fault information and send it to Huawei technical support engineers. For the contact information, see 1.6 Technical Support.
	Step 9 If you have performed the preceding steps, make a call to check whether the fault is rectified.


	5.3  Transfer Service Faults
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the network connection is normal. See 2.5 Network Information Analysis.
	Step 2 Run the show subscriber dn <string> command to check whether user B has the right to call user C. The user number 5001 has intra-office call right and local call right, as shown in Figure 5-1.
	Figure 5-1 Outgoing call right

	Step 3 See related IP phone documents to whether the operation and configuration of IP phone is correct.
	1. Check whether the transfer service operation performed on the SIP phone is correct.
	2. Check whether the phone supports the hookflash function.
	3. Check whether the SIP phone configuration is correct.
	Figure 5-2 Digit collection mode
	Figure 5-3 Voice codec mode
	Figure 5-4 DTMF payload type


	Step 4 If B uses a POTS phone, check whether the hookflash duration on the POTS phone is different from that on the SoftCo and check whether the hookflash key is available.
	Step 5 If B is connected to the IAD, run display version command to check whether the IAD supports the hookflash function.
	Step 6 If the SoftCo uses the SIP trunk to connect to the peer device, check whether the SoftCo and the peer device use the same digit collection mode.
	1. Run the show cdsp argu command to view the digit collection mode. The RFC2833 digit collection mode is disabled by default. This means that RFC2833Flag:0 is displayed.
	2. Run the config cdsp rfc2833switch <on|off> command in Config mode to enable the RFC2833 digit collection mode.
	3. Run the show cdsp payloadtype command to check whether the RFC2198 load (the value of PayloadTpye) is the same as that of the peer device.

	Step 7 See 2.3 Log Analysis to capture the log and rectify the fault.
	Step 8 If the fault persists, see 1.6 Technical Support to obtain technical support.


	5.4  ONLY Service Faults
	5.4.1  ONLY Number cannot be bound
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show subscriber dn <string> type newservice command to check whether the primary terminal or the number to be bound has ONLY service, as shown in Figure 5-5.
	Figure 5-5 ONLY service

	Step 2 Run show subscriber command to check whether the number to be bound exists.
	Step 3 Run show subscriber command to check whether the ONLY service is enabled for the number to be bound (value of BindUserNum).
	Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support.


	5.4.2  The User Hears the Busy Tone When Dials the ONLY Number
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show subscriber unicall dn<string> command to check whether the value of BusySelectMode is active.
	Step 2 Check whether the main terminal is the SIP terminal.
	Step 3 If the fault persists, see 1.6 Technical Support to obtain technical support.


	5.4.3  The Sequential Ringing Service or the Simultaneous Ringing Service Fails through ONLY Service
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show subscriber unicall dn <string> command to check whether related attributes are correct, as shown in Figure 5-6.
	Figure 5-6 ONLY information

	Step 2 Check whether the services enabled for the bound users conflict with the ONLY service. For details about related services, see 5.1.2 ONLY Service.
	Step 3 If the fault persists, see 1.6 Technical Support to obtain technical support.



	5.5  Main Number Service Fault
	5.5.1  Prompt Message Faults By Main Number Service
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show prefix dn <string> command to check whether the access code for the VU main number is correct. The value of If4PSTN should be yes.
	Step 2 Run the show board command on the SoftCo9500 to check whether the MRU or MRS is in OK state.
	1. Remove and then reinstall the MRU or MRS, or replace the MRU or MRS.
	2. Log in to the DTU and MRU through the serial port and run the show version command to check whether the versions of the DTU and MRU are the same as the version of the MCU. For details on how to log in to the MRU or MRS through the serial port, see How t[

	Step 3 Check whether the VU script is imported correctly.
	Step 4 Run the show prefix callcategory vu command to check whether the value of Vug is the same as the value of define OperationNO in the VU script, as shown in Figure 5-7 and Figure 5-8.
	Figure 5-7 Vug value
	Figure 5-8 VU script

	Step 5 Check whether the channel for playing prompt messages in the script is correct, as shown in Figure 5-8.
	Step 6 Run the show protocol <at0|cassignal|isup|tup|pra|sip|h323> command to check whether the default incoming number is set. The default incoming number is set to be 88888888, as shown in Figure 5-9.
	Figure 5-9 Default incoming number

	Step 7 See 2.3 Log Analysis to capture the log and rectify the fault.
	Step 8 If the fault persists, see 1.6 Technical Support to obtain technical support.


	5.5.2  User Faults By Main Number Service
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the VU script is imported correctly.
	Step 2 Check whether the script is correct, as shown in Figure 5-10.
	Figure 5-10 VU script

	Step 3 If the SoftCo uses the SIP trunk to connect to the peer device, check whether the SoftCo and the peer device use the same digit collection mode.
	1. Run the show cdsp argu command to view the digit collection mode. The RFC2833 digit collection mode is disabled by default. This means that RFC2833Flag:0 is displayed.
	2. Run the config cdsp rfc2833switch <on|off> command in Config mode to enable the RFC2833 digit collection mode.
	3. Run the show cdsp payloadtype command to check whether the RFC2198 load (the value of PayloadTpye) is the same as that of the peer device.

	Step 4 See 2.3 Log Analysis to capture the log and rectify the fault.
	Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support.



	5.6  Fax service fault
	5.6.1  Faults Occurring When Sending or Receiving Faxes
	Symptom
	Possible Causes
	Procedure
	Step 1 Verify that the network quality meets the requirement. For details, see 2.5 Network Information Analysis.
	Step 2 Verify that operations on the fax machine are correct.
	1. Before sending a fax, verify that papers are properly placed to the paper tray, and the fax machine is ready.
	2. When sending a fax, press the start button only after hearing the fax confirm tone sent by the other party.
	3. Check whether the memory of the fax machine is used up. If the memory is used up, clear the memory.
	4. Check whether papers are placed to paper trays of both sender and recipient fax machines. If there are papers on both fax machines, remove the papers from the recipient fax machine.

	Step 3 Verify that the fax machines are correctly set.
	1. If no fax can be sent, check whether the pulse dialing mode has been enabled. If this mode has been enabled, change it to the touch-tone dialing mode.
	2. If no fax can be received, check whether the function of rejecting faxes has been enabled. If this function has been enabled, disable it.

	Step 4 Check whether the transparent transmission mode has been enabled for the SoftCo, IAD.
	Step 5 Adjust the sending and receiving gains to ensure that faxes can be sent and received successfully.
	Step 6 Use the comparison test to locate faults.
	1. Change a fax machine, and then verify that faxes can be sent and received successfully.
	2. Change a phone line of IAD, and then verify that faxes can be sent and received successfully.
	3. Change a trunk line, and then check whether faxes can be sent and received successfully. If the faxes can be sent and received successfully, contact the carrier to locate line faults.
	4. If faxes failed to be sent or received when a 32-port IAD is used, replace it with a 4-port IAD and check whether faxes can be sent and received successfully.

	Step 7 Use a packet catcher to capture signaling and RTP packets, and then rectify faults. For details on how to use the packet catcher, see How to Use the Wireshark.
	1. Check whether a re-invite message exists in the signaling process. If the message does not exist, use the Capsens to convert the captured RTP packets to a voice file, and then analyze the file. If the voice file is empty, analyze the log of the device t_
	2. Check whether the codec type and packaging duration contained in the re-invite message are the same as those contained in the 200 OK message.
	Figure 5-11 Voice codec type on the SoftCo

	3. Check whether the value of Ptime in the RTP package that was sent is the same as that in the RTP package that was received. If they are different, contact Huawei technical support.

	Step 8 Use the CoolEdit to analyze the fax signals and rectify faults. For details on how to use the CoolEdit, see 8.2 How to use the CoolEdit.
	Figure 5-12 Waves for fax signals in normal cases
	Figure 5-13 RMS power in normal cases
	Figure 5-14 Waves for signals of faxes that cannot be sent
	Figure 5-15 Waves for signals of delayed faxes

	Step 9 If the Time Division Multiplexing (TDM) trunk is used, see 4.2 E1 Trunk Exception to check whether the clock source has been configured.
	Step 10 If the fault persists, see 1.6 Technical Support to obtain technical support.


	5.6.2  Fax Quality Is Low
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether situations such as packet loss, delay, or jitter occur on the IP bearer network. For the detailed procedure, see 2.5 Network Information Analysis.
	Step 2 Check whether the SoftCo is grounded.
	Step 3 If the Time Division Multiplexing (TDM) trunk is used, see 4.2 E1 Trunk Exception to check whether the clock source has been configured.
	Step 4 If the fault persists, see 1.6 Technical Support to obtain technical support.



	5.7  Typical Cases
	5.7.1  The System Asks the User to Press 0 to Forward the Call to the Reception Desk or Press 5 to Enter the VoIP Process When a User Dials the Main Number
	Symptom
	Possible Causes
	Procedure

	5.7.2  The Called Phone Rings Abnormally After the Calling Party Hangs up the Phone
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show peercomponent command to check the domain name set on the SIP trunk (the value of DomainName).
	Step 2 Run the show ims connectpara command to check the domain name set in the IMS connection parameters (the value of DomainName).
	Step 3 In Config mode, run the config modify peercomponent domainname<string>ip <A.B.C.D>tkcnum<1–1200> or config modify ims connectpara domainname<string>ip <A.B.C.D>officeselectcode<0–254>mode <master|slave> command to set domain names to the same.


	5.7.3  One or More User Phones Fail to Ring When the ONLY Service Is Used
	Symptom
	Possible Causes
	1. Run the show subscriber dn <string>type all command. If the value of PARALLEL_RING_SERVICE is Y, the sequential ringing service is enabled.
	2. Run the show ringservice dn <string> command to view the numbers used in the sequential ringing service and run the show subscriber unicall dn <string> command to view the numbers in the ONLY service. You can find that the same number is used in the twoe

	Procedure

	5.7.4  Call Transfer Service of a SoftCo User Is Abnormal When the SoftCo Is Connected to the IMS
	Symptom
	Possible Causes
	Procedure

	5.7.5  No Prompt Message is Played When the Mobile User Rejects the Call
	Symptom
	Possible Causes
	Procedure

	5.7.6  IMS User Cannot Be Called in the Simultaneous Ringing Service (ONLY)
	Symptom
	Possible Causes
	Procedure

	5.7.7  Fault Occurs When an IMS User Is Connected in the Simultaneous Ringing Service (ONLY)
	Symptom
	Possible Causes
	Procedure

	5.7.8  IMS User Cannot Transfer Calls
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show prefix dn <string> command to check whether the registration group ID (RegGroupId) is added to the VU prefix.
	Step 2 On the IMS, check whether the user to whom the call is to be transferred exists or whether the user is idle.
	Step 3 On the IMS, check  whether  the CFB service and call holding service is enable.
	Step 4 If the fault persists, contact Huawei customer service center or the local office.


	5.7.9  Fax Fails When the SoftCo Is Connected to the IMS
	Symptom
	Possible Causes
	Procedure
	Step 1 Use the packet capture tool to capture the INVITE SDP message form the peer device, then discover the SDP message's media attribute is modem, as shown in Figure 5-16.
	Figure 5-16 SDP message

	Step 2 Run the show softagru command to view the software parameter ID of fax and modem sdp attr mode (the value of Tpye).
	Step 3 Run the config softargu type 255 value 0 command to modify the media attribute to FAX/MODEM.


	5.7.10  Faxes Cannot Be Sent Using T.38
	Symptom
	Possible Causes
	Procedure



	6  System Device Faults
	About This Chapter
	6.1  Faults Occurring During the Upgrade
	Symptom
	Possible Causes
	Procedure
	Step 1 Connect to the SoftCo through the serial port. See How to Connect to the SoftCo Through the Serial Port or by Telnet.
	Step 2 Start the BOOT1 mode and run the KDF command to delete all the data from the Flash memory, as shown in Figure 6-1.
	Figure 6-1 Deleting data

	Step 3 Run the boot command to restart the SoftCo.
	Step 4 Upgrade the SoftCo again. For details, see the SoftCo Upgrade Guide.


	6.2  Power Supply Exception
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the RUN indicator is normal. Take measures according to the indicator status, which is described in 2.2 Alarm Analysis.
	Step 2 Check whether the power module and power cable are fastened. Remove and reconnect the power cable and power on the device to check whether the alarm is cleared.
	Step 3 Check whether power modules and filler panels in other slots are fastened and whether all idle power modules are powered on. If no, fasten power modules and filler panels and power on idle power modules.
	Step 4 Fasten and power on the power modules. Then check whether an alarm is generated. If so, replace the power modules or filler panels.
	Step 5 If the fault persists, see 1.6 Technical Support to obtain technical support.


	6.3  Typical Cases
	6.3.1  Voice Service Fails Frequently After the SoftCo Is Upgraded
	Symptom
	Possible Causes
	Procedure
	Step 1 View the alarm information through the OMU. You may find that alarms such as SIP terminal failure are reported continuously even at night when there is no or low traffic. In addition, the phone sets do not receive a response to the re-registration rl
	Step 2 View the status of the Ethernet switch that connects to the SoftCo. You can find that the Ethernet switch works in half-duplex mode at 100 Mbit/s, whereas the SoftCo works in full-duplex mode at 100 Mbit/s. The packet loss rate is high due to the dil
	Step 3 Change the working mode of the Ethernet switch because the network adapter of the SoftCo does not support automatic negotiation. For example, run the following command to change the working mode of the switch in a specific office:


	6.3.2  Uploading or Downloading a File Fails
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the license.dat file on the TFTP server is named correctly. The correct file name is license.dat.
	Step 2 Start the Config mode of the SoftCo and run the config system hostip <A.B.C.D> command to set a correct IP address for the TFTP server.
	Step 3 Check whether the loading directory on the TFTP server is correct.


	6.3.3  Pinging Another Device from the SoftCo Fails
	Symptom
	Possible Causes
	Procedure
	Step 1 Verify that device A and the switch are connected and the network cable is normal.
	Step 2 Verify that the SoftCo and the switch are connected and the network cable is normal.
	Step 3 Run the show system information command to check the network configuration of the SoftCo.




	7  Terminal and gateway faults
	About This Chapter
	7.1  IP Phone
	7.1.1  IP Phone Cannot Be Started
	Symptom
	Possible Causes
	Procedure
	1. Connect the PC and IP phone to the same hub. Check and ensure that only one network adapter is installed on the PC. If more than one network adapter is installed, enable one network adapter and disable the others.
	2. Set the IP address of the PC to 168.75.215.188, the subnet mask to 255.255.0.0, and the IP address of the gateway to 168.75.215.188.
	3. Start the Trivial File Transfer Protocol (TFTP) server on the PC, set the load directory, and start the TFTP service. Then place the upgrade software to the load directory.
	4. Press *+# on the IP phone, cut off the power supply, and restore the power to start the IP phone. The IP phone will download software from the TFTP server.


	7.1.2  IP Phone Is Disconnected from the Network
	Symptom
	Possible Causes
	Procedure
	Step 1 Check and ensure that the LAN interface is connected to the switch.
	Step 2 Check and ensure that fields such as IP addresses are set correctly. For detailed operation, see the related IP Phone document.


	7.1.3  Web Pages Cannot Be Configured
	Symptom
	Possible Causes
	Procedure

	7.1.4  IP Phone Can Receive Incoming Calls but Cannot Make Outgoing Calls
	Symptom
	Possible Causes
	Procedure
	Step 1 Log in to the Web page of the IP phone with an administrator account, and then access the SIP configuration page.
	Step 2 Set the SoftCo as the proxy server. For the ET522, enter the IP address of the SoftCo in the SIP Proxy Server text box.


	7.1.5  IP Phone Can Receive Outgoing Calls but Cannot Make Incoming Calls
	Symptom
	Possible Causes
	Procedure

	7.1.6  IP Phone Cannot Provide Two-Stage Dialing
	Symptom
	Possible Causes
	Procedure

	7.1.7  IP Phone Cannot Obtain Time from the NTP Server
	Symptom
	Possible Causes
	Procedure
	Step 1 Check the version of the ET523 on the STATUS page. If the version is V1.1.2.4, upgrade it to a later version.
	Step 2 If the firewall is installed on the PC, rectify the fault in one of the following ways:



	7.2  IAD
	7.2.1  The System Time Restores to the Factory Setting After the IAD Is Restarted
	Symptom
	Possible Causes
	Procedure
	Step 1 Start the SNTP service of the SoftCo.
	Step 2 Start the SNTP client on the IAD to keep time synchronization with the SoftCo.
	Step 3 If many IADs are used, and you have the UCEMS tool, you can enable the SNTP function of the IADs in batches on the UCEMS.
	Figure 7-1 Enabling the SNTP function of the IADs in batches through the UCEMS



	7.2.2  Call Is Abnormal If an IAD User Does Not Dial #
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the show version command check whether the SoftCo support the function of reporting a number digit by digit. Versions later than V100R002C02B089 support the function of reporting a number digit by digit.
	Step 2 Set a digitmap so that the user does not need to dial the pound key (#).
	1. Run the show softargu command on the SoftCo to view the value of Tpye corresponding to sip suppont iad no pond switch.
	2. Depending on the SoftCo version, you can use either of the following methods to set a digitmap:



	7.2.3  Dialing Error Message Is Played When an IAD User Dials an Extension Number
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the sip send-capability 2833 command on the IAD to enable the RFC2833 dialing mode.
	Step 2 Run the config cdsp rfc2833 switch on command on the SoftCo to enable the RFC2833 dialing mode.


	7.2.4  IAD User Hears Beeps During a Call
	Symptom
	Possible Causes
	Procedure

	7.2.5  Low Volume for an IAD User
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the dsp send-gain<2,64> command to adjust the DSP transmit gain.
	Step 2 Run the dsp recv-gain<2,64> command to adjust the DSP receive gain.


	7.2.6  Call Ends When the IAD user Is Picked Up in Hands-free Mode
	Symptom
	Possible Causes
	Procedure
	Step 1 Run the devasi parameter set ? command to view the maximum and minimum hookflash durations for the IAD, as shown in Figure 7-2.
	Figure 7-2 Maximum and minimum hookflash durations

	Step 2 Run the devasi parameter set 3 80 command to increase the maximum hookflash duration.
	Step 3 Run the devasi parameter set 3 50 command to decrease the minimum hookflash duration.


	7.2.7  Echoes Can Be Heard When an IAD User Calls a PSTN User
	Symptom
	Possible Causes
	Procedure
	Step 1 Check whether the echoes are acoustic feedback from the user's microphone.
	Step 2 Check whether the EC is set correctly.
	Step 3 Run the pstnport attribute set command on the IAD to reduce the receive gain and transmit gain.
	Step 4 If the fault persists after you adjust the port gains, on the IAD, run the dsp recv-gain command to adjust the DSP receive gain, and run the dsp send-gain command to adjust the DSP transmit gain.
	Step 5 Contact the peer office's engineers to check whether the EC parameter of the peer gateway is set correctly.




	8  Common Tool
	About This Chapter
	8.1  How to use the Capsens
	Context
	Procedure
	Step 1 Double-click , run Capsens.
	Step 2 Choose Tool > CAP2WAV, the Cap file convert to wav file is displayed.
	Step 3 Click  , choose the relevant file which need to convert.
	Step 4 Click Convert to change .cap to .wav.


	8.2  How to use the CoolEdit
	Context
	Procedure
	Step 1 Double-click  , run CoolEdit.
	Step 2 In the main menu, choose File  > Open. The open dialog is displayed. Then choose .wav file. the waveform is displayed in the main interface, as shown in Figure 8-1.
	Figure 8-1 Wave spectrum

	Step 3 In the toolbar click , the frequency spectrum is displayed, as shown in Figure 8-2.
	Figure 8-2 Frequency spectrum

	Step 4 In the toolbar click  to contrasting send and receive signal, as shown in Figure 8-3.
	Figure 8-3 Contrasted signal spectrum

	Step 5 In the main menu, choose Analyze > Statistics, the Waveform statistics is displayed, as shown in Figure 8-4.
	Figure 8-4 Waveform statistics





